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Cushcraft r7 repair

PowerSDR VAC1 & VAC2 (Virtual Audio Cable) VAC1 and VAC2 allow you to connect PowerSDR Audio In/Out to your PC without using real analog cables. If you want to use your PC as a MIC and Speaker for your Flex Radio, select VAC1 as follows: Driver: DirectSound Driver (you can set the buffer latency down to 90 msec on a fast PC) Input:
Primary Sound Capture Driver Output: Primary Sound Driver Then in Windows Control Panel->Sound, Make sure the Playback and Recording devices match your Speaker and Mic and make sure the Sample Rates match If you want to connect Digital Mode programs on your PC to PowerSDR (like FLDIGI, MIXW, WSJT-X, MMSSTV, NAVTEX,
"DREAM", MULTIPSK, SIGMIRA, "SORCERER", PC-ALE, FREEDV, YADD, CWSkimmer, RMS Express, PC-HFDL), Download and install "VoiceMeeter Banana". It includes drivers for MME, DirectSound, and WDM-KS. You dont need to run VoiceMeeter Banana, just install it to get the drivers. Think of a virtual audio channel as a single RCA cable, one
end is the Input, the other end is the output. And the AUX cable is a second RCA cable. VoiceMeeter Banana Drivers install into your PC SOUND Playback and Recording devices as follows: PLAYBACK "VoiceMeeter Input VAIO" "VoiceMeeter Aux Input VAIO" and RECORDING "VoiceMeeter Output VAIO" "VoiceMeeter AUX Output VAIO" These VM
devices work like a physical Audio Cable with 2 ends (but audio only goes in Input end): VoiceMeeter Output Open Sound Settings, and set the Playback device to "VoiceMeeter Input" Now: when you PTT your Radio, you can Talk and play PC audio out the Flex Radio CW Skimmer: Check the Direct I/Q BOX, when using CWSkimmer, since it requires
I/Q audio and be sure to use only DIGIU mode ------------------------------------------------------------------------------------------------------------------------------- WDM-KS Drivers(Windows Driver Mode - Kernal Streaming) Windows "WDM-KS" (Windows Driver Mode - Kernal Streaming). WDM-KS allows for a very low audio Latency. As low as 15 to 20mSec (similar to ASIO). If you
cannot find a suitable WDM-KS Driver, download the free "Voice Meeter Banana" program. You do not need to use the Audio PC program, install it just for the drivers. WARNING: WDM-KS drivers are can cause crash issues (DirectSound is the safer alternative). With WDM-KS only 1 device can use a WDM-KS device at 1 time, so If you accidently try
to open a 2nd PC program using a WDM-KS driver, the driver will crash, forcing you to reboot your PC. Also the windows Control panel->Sound does not show WDM-KS drivers. But you can see which devices have WDM-KS drivers in PowerSDR when you select WDM-KS as the driver and check INPUT and OUTPUT devices. Flex 5000 AUDIO eSSB /
AM Setup I now use a audio-technica BPHS1 studio headset/ dynamic microphone (40-20,000hz). Although Condenser microphones are typically superior in sound quality and possess a lower bottom end, there are some downsides. They are typically large, heavy, and very sensitive to noise. (The "Dynamic microphone" design is very compact &
provides much less noise pickup) MIC2200: MIC BALANCED IN -> BALANCED OUT TO DEQ2496 Set Gain to get -20db out level DEQ2496: MIC2200 BALANCED RIGHT IN -> BALANCED RIGHT OUT EX3200 PEQ: Setting for 3-6khz wide SSB Audio PEQ: Setting for 10khz AM audio [ie +/- 5khz] or FM modes (NOTE: Do not add BASS to your audio
in AM mode) (See N9UN's site for full setup details of 2496) Dynamic Equalizer (used to limit the EQ based on audio level ) DEQ1 (low end volume EQ): 1: - 14, - 48db, 1:8 2: 1.28,-48db, 69.6 3: BP,42.3,4 DEQ2 (mid range volume EQ): 1: -15,-47db,1:10 2: 14.76,-47 db, 62.7 3: BP,408,5 DEQ3 (high end volume EQ): 1: -14, 26db,1:6 2: 0.3, -26db, 45.9 3:
BP, 10023,5 Dynamic Expander/Compressor/Limiter DYN Expander (used to gate background noise): 1: -6, 21db, 1:1.6 2: 2.77, 87.4 LIMIT: 30.6,-11,304 UTILITY: DUAL MONO, Gain offset +10 Switch on back: IN EX3200: DEQ 2496 BALANCED LEFT IN -> TRS LEFT OUT -> INVERT Wires -> TRS RIGHT IN -> BALANCED RIGHT OUT LEFT : OUT,
2, OUT, IN, 3, 3.3, Full EXCITER, 3, IN (solo OUT), Surround IN, 2 RIGHT: OUT,2,OUT,IN,6, 4.5,Full ENHANCER,3,IN (solo OUT) DSP1000P: EX3200 BALANCED LEFT IN -> BALANCED LEFT OUT PowerSDR Plate Level 2 ---------------------------------------------------------------------------------------------------------------------------------------------------- eSSB Mode Operation
(proper setup) PEQ: (setting for 6khz eSSB audio Audio Technica) Create a Transmit profile just for eSSB mode: 1) Set your Transmit bandwidth to 0hz to 6000hz (low= 0hz, high = 6000hz) 2) Console->Mixer->Input->Mic or Bal Line In->Slider 3/4 of the way up (value = -33) 3) Setup->DSP->AGC/ALC->Leveler-> Gain = 5, Attack = 1, Decay = 125,
Hang = 170 4) Setup->DSP->AGC/ALC->ALC-> Attack = 1, Decay = 20, Hang = 170 5) PowerSDR Console->DX = 2 (Compressor works perfect for eSSB mode) 6) Set MIC Level so your ALC and MIC hit 0dB on the meter (its ok to have peaks over 0dB on the PowerSDR meter) 7) Setup->Transmit->Mic Boost ON (if you find you need to keep the mic
sliders all the way up) 8) Save your new eSSB transmit Profile ---------------------------------------------------------------------------------------------------------------------------------------------------- AM Mode Operation (proper setup) PEQ: (setting for 10khz AM audio [ie +/- 5khz] or FM modes Audio Technica) Create a Transmit profile just for AM mode: 1) Set your Transmit bandwidth
to 0hz to 4000hz, or 5000hz (low=0hz, high=5000hz) 2) Console->Mixer->Input->Mic or Bal Line In->Slider 3/4 of the way up (value = -33) 3) Disable the ALC: Setup->DSP->AGC/ALC->ALC Attack = 1, Decay = 1, Hang = 10 4) Setup->Transmit->AM->Carrier Level = 7 (as a starting point) 5) PowerSDR Console->Drive Level = 100. Adjust Carrier
for 25 watts out (for 100 max Radio) 6) PowerSDR Console->CPDR = 5 (Compander works perfect for AM mode) 7) If using an internal or external EQ, remove any bass boost. Boost the high end. 8) Set MIC Level so your audio output on the Panadapter does rise higher than 3/4 of the way to the peak of the Carrier you see on the screen 9) Setup>Transmit->Mic Boost ON (if you find you need to keep the mic sliders all the way up) 10) Save your new AM transmit Profile 100% modulation would be when total PEP is 4 times the carrier. You can go a little higher if the listener is using SAM instead of AM mode. -------------------------------------------------------------------------------------------------------------------------------------------------------- ADDING AN XLR/TRS Combo Connector Below you can see where the XLR / TRS Combo Balanced line connector goes. I added shielding over the connector when I was done. You cant quite get the XLR/TRS Combo connector close enough to the original TRS hole, so there is a small gap between the XLR and panel in the top right of
the above picture. I PowerSDR KE9NS v2.8 Feature explanation "SWL List" Key word search: ALE: Automatic Link Establishment (Decode using PC-ALE) WWV, Time: Time signals (Both Voice and digital. Decode using WWV HF checkbox and Time Sync button) VOLMET: Weather information for Aircraft in Flight (Voice) HFDL: HF Data Link for
Aircraft location (Decode using PC-HFDL) Digital: DRM Radio stations (Decode using DREAM decoder) Stanag: UN / Military digital (Decode using Sigmira or Sorcerer) Fax: Weather charts (Decode using Fldigi) DSC: Digital Selective Calling for Marine ships reporting position or emergency (Decode using Yadd) Navy: Navel trafic (Voice) Navtex:
Digital Marine Weather (Decode using Navtex) Mobile: Mobile Marine Radio Maritime: voice Maritime traffic Beacon: NCDXF/IARU Beacons (see ncdxf.org for details). _______________________________________________________________________ PowerSDR KE9NS "Voacap" Propagation Mapping: Example ss:0 ef:15 SpW: (ss) is the official optical sunspot
number from SIDC. The higher the better. (ef) is the effective sunspot number, which is based on soundings of the ionosphere, but only for the mid latitudes of the earth. The effective SunSpot number is more accurate than the optical. The higher the better. The only number you want low is the (K) (high K means signals will likely be scattered rather
than reflected) VOACAP propagation uses the (ef), so its more accurate, but it doesn't take high (K) values or (SpW) geo storms into account. VOACAP propagation assumes you have a rotatable dipole or 3 element beam at 35' (if you select it) Dots: The Dots show signal strengths computed for the exact locations over the map. Areas on the map with
small or no Dots have the weakest signals. Large Dots have stronger signals. Blue is the strongest signal, then Green, then Orange, then Yellow, then Gray Contours: Contour lines are derived by a formula from the dots, but can sometimes be difficult to see coverage gaps on the map. Blue is the strongest, then Green, then Orange, then Yellow, then
Gray. The problem with contours is it is hard to determine the Gaps in coverage. You may see a Blue contour line, but if you change over to the Dots map, you will see no signal strength adjacent to the Blue area of the map. (i.e. a Gap) Reasons you may hear stations when the Propagation map shows no conditions: Some Ham Radio stations have large
Antenna arrays and may show up on an empty part of the Propagation map, due in part to their very large Effective Radiated Power (ERP) when compared to a wire dipole. Or, at 27mhz or above, Tropospheric Ducting Propagation maps (see and/or Sporadic E propagation (Estimated Sporadic E layer (DXMAPS.com)) You may not hear stations that
are in a Blue or Green area of the map, due to Antenna directionality, takeoff angles, Geo Storms,or high K readings, or they may be in Gaps found in the propagation area __________________________________________________________________ DX Cluster Lists: See for a list of DX clusters that you can add to the list in PowerSDR Spotter window.
__________________________________________________________________ PowerSDR S-Meter dBm vs Panadapter dBm: Why is the S-Meter reading showing a signal level different from the signal I see in my Panadapter bandpass? This is because the S-Meter reading is the Sum of all the DSP FFT bins taken within the bandpass filter. And they are related by
20log(bandwidth inside receiver filter / bin size of FFT) as per N5AC. If you were to close down your bandpass to around 10hz, the signal within that bandpass and the S-Meter should now be the same dBm (if both meters are running at the same refresh rate and you take into account any averaging being done). So, as you open up the bandpass filter,
the S-Meter will rise as you add (sum) more bins. This is as it should be and works the way a traditional S-Meter works. Note: the S meter scale on the right side of the Padapter is approx because it only follows the dBm markings found across on the left side of the Panadapter. So in order to see a correct scale on the right side matched to the left side,
you would need to set your setup->Display->Spectrum Grid->Max = -19, Min = -135, Step = 6 (S signals are 6 dBm apart). But if you use the Auto Pan Lvl button, the Max value will change automatically. PowerSDR S-Meter dBm vs Panadapter dBm and S-Meter Scale. __________________________________________________________________ PowerSDR ke9ns
keyboard and Mouse shortcuts: with all the Hidden menus keyboard shortcut pdf KE9NS v2.8 Revision History 3/22/22 v2.8.0.251: Tweak the Pan display while scrolling the VFO with AVG or AvgP enable (with Setup->Display->"Avg Pan Move" enabled). Update FCCDATA.dat and SWL.csv files 2/19/22 v2.8.0.250: Fix 12m bandtext. Click on Setup>General->Options->Update BandText after the update. Update SWL.dat file. 1/20/22 v2.8.0.249: Fix moving panadater (left/right) with mousedown and drag operation with ESC panel enabled. Add VFOB option for PowerMate knob (push Knob to toggle between A/B). Setup->General->User Interface->Push VFO select. 1/18/22 v2.8.0.248: Fix
Extended mode band properly matches to nearest ham band calibrations. 1/10/22 v2.8.0.247: Fix ToolTips for ESC Diversity panel and add the 180deg reversal button. 1/2/2022 v2.8.0.247: Fix TURF band button issues with smaller band segments causing issues with SWL bands and Ham bands. Update SWL listing. Tweak Diversity panel button skins.
12/26/21 v2.8.0.246: Diversity Reception ESC window "optional" integration directly on PowerSDR console screen. Setup->General->RX2->ESC integrated into Console Screen. 12/18/21 v2.8.0.245: Minor tweaks to the console "Maps" button (including F1 help, and F2 video help) 12/9/21 v2.8.0.245: Fix Alpha fault due to rounding error (3D
panadater). 3D panadater now allows for larger 3D display when in "Pandapter" only Display mode (setup->Appearance->General->3D z offset), along with setup->Appearance->Display->3DAlpha and 3DPan color 12/6/21 v2.8.0.244: Add Scanner (memory scanner) now runs on VFOB (RX2) or VFOA (RX1). VFOB (RX2) when you Mouse Wheel Click
the "Memory Scan (RX)" button. Left Click for normal VFO Scanner. 12/4/21 v2.8.0.243: fix Buffer latency lower limit for WDM-KS (B). Fix font issue 12/3/21 v2.8.0.243: Mod: Setup->Audio->Vac1->Buffer Latency (A and B). To allow separate Buffer latency for VAC1 A and B setups. "Maps" button: (LEFT CLICK)= Active Spotter world map (with
VOACAP propagation map enabled), (RIGHT CLICK)= real-time F2 layer, real-time D layer, real-time Lightning stikes, real-time IR Cloud cover: 11/23/21 v2.8.0.242: Add: Mouse over Panadapter area then Hold CTRL+Z to open Zoom window (you can now move mouse around Panadapter area to move Zoom window. Let go CTRL+Z to close Zoom
window. For lightning and Cloud maps only. (Testing) 11/21/21 v2.8.0.241: Add IR Cloud cover world map (Testing). Real-time Mosaic of images but missing the lower center section. Select from either Spotter screen or Right Click on Console "Map" button to Toggle between Real-Time F-Layer Map, D-Layer Map, Lighting Map, and IR Cloud cover
Map. Left Click for standard Spotter World Map. Update SWL listing. 11/20/21 v2.8.0.240: Add current real-time Lightning map (Testing). 11/14/21 v2.8.0.239: Turn off most layers when F or D layer turned on to make it easier to see. Main PSDR Console "Map" button new functions as follows: RIGHT click to toggle between F and D layers, LEFT click
to toggle main World Map, WHEEL Click for external window very large world map Update SWL listing (donate to eibispace.de) 11/13/21 v2.8.0.238: Once again compiled under VS2022 but using .NET 4.5.2 and tested to work with comma decimal point. (decimal point culture issues with using .NET 4.6 or higher). 11/12/21 v2.8.0.238: Went back to
VS2019 and .NET 4.5.2. Something in .NET 4.7.2 causing issues with using the comma instead of period as a decimal point. 11/11/21 v2.8.0.237: Compile using VS2022 and .NET 4.7.2. Improvments to F and D layer maps 11/7/21 v2.8.0.236: Fix RX2 FM mode startup selecting the correct dev. Add right click on FM button to toggle 2k,5k,wide FM dev
modes. Update FCCDATA callsign database 11/6/21 v2.8.0.235a: fix VAC1 causing crash when using RX2 Auto VAC2 option. 11/5/21 v2.8.0.235: add foF2 layer 11/4/21 v2.8.0.234: Starting to incorporate the "Global real time NOAA D-layer absorption world map", And the SWS Austrialia "Global real time Ionospheric foF2 world map" as a layer as well.
11/3/21 v2.8.0.233: Fix Setup->General->RX2->Turn ON VAC2, if you try to manually turn off VAC2 with RX2 still on. 10/31/21 v2.8.0.232c: Fix Spotter Pause to stay paused when mouse over the scroll bar and automatically un-pause if spotter window goes out of focus or mouse moves off the spotter window. 10/31/21v2.8.0.232: Fix Spotter screen
"Pause" function. Add: Cursor over Spotter Window to automatically "Pause" Spotter screen, visable by a yellow "Paused" (when spots are coming in too fast). Panadapter and world map spots continue to update, only the Spotter window is paused. Fix ToolTip Flicker in spotter screen. Update DXCC.txt file. 10/29/21: v2.8.0.231: Fix BandStack location
if next to Panadapter screen (due to larger VFO display option). Fix Setup->General->RX2->Turn ON VAC2 feature will now auto turn on/off with RX2 turning on/off. 10/28/21 v2.8.0.230: Fix memory RX2 not auto on. Add: Setup->General->RX2->Turn ON VAC2 when RX2 turned ON (but only when the RX2 auto on is also on. Mod: Scanner Mouse
wheel Click = VFOB So Memory, Scanner and Spotter are all Mouse wheel click = VFOB), Memory Screen: Left Click = VFOA, Mouse Wheel Click = VFOB, Right Click = go to hyperlink (browser) Scanner Screen: Left Click = VFOA , Mouse Wheel Click = VFOB, Right Click = Scanner channel ignore Spotter Screen: Left Click = VFOA, Mouse Wheel
Click = VFOB, Right CLick = open QRZ.com (browser) 10/26/21 v2.8.0.229: XVTR max frequency increased from 99GHz to 250GHz. Add in XVTR screen: Hover mouse over "Button Text" buttons to view each "Translated" Frequency (MHZ) based on Begin, End and LO Offset. Add: Setup->General->RX2->Sending spotter,memory or Scanner Freq to
VFOB turns on RX2 automatically. 10/24/21 v2.8.0.228: Add Setup->Appearance->General-> Larger VFO window, to allow VFO frequencies 10GHZ and above room in the VFO (due to the larger font sizes). Fix issue with frequencies above 24GHZ causing Pan display to crash when in setup->Display->"Hi-Res PanaFall" mode. Fix BandStack to allow
Frequencies over 10GHz. Updated BandText for most GHz ham bands. Must go to Setup->General->Options->Update BandText to activate the update. 10/23/21 Upgrade to Win11 Pro. Compiled PowerSDR under VS 2019 + Win11. Those running Win11 will notice a slight difference in appearance (see above for a visual). Its a little easier to see
checked boxes. And the corners of all the windows and interfaces are now rounded (similiar to what I did to the console screen a while back) 10/16/21 v2.8.0.227: Fix Setup->general->Options->Disable Split on Mode Change. Was not properly changing modes when it disabled the SPLIT feature. 10/5/21 v2.8.0.226: Update FCCData for LoTW spotter.
Scanner mod: Memory scanner: Left click on any displayed memory channel to send to VFOA, Right Click to send to VFOB. Wheel Click to Toggle memory channel scan bypass OFF = X , ON = blank. If "Pause Scan" is yellow due to a squelch break (busy channel), click on Pause scan to resume scan, or Wheel Click on the memory channel to bypass
this channel from the current memory scan. 9/29/21: v2.8.0.225: Fix issue with RX2 Cursor Offset and frequency values (lower left numbers of Display area) because of RX2 ZOOM and Center. Mouse wheel click over CENTER to re-center RX2. Mouse wheel click over zoom x0.5 x1 x2 x4 buttons to zoom RX2 (Right click is a times10 button for RX1
only) 9/25/21 current source code can be found at: 9/17/21 v2.8.0.224: Incremental download is now a .msi (removed the zip folder) 9/7/21 v2.8.0.224: Fix SWL auto Google search (Focus PowerSDR, mouse over SWL listing on Panadater, and Right Click to Google SWL station), OR "CTRL" over SWL Station to set Freq and Mode. Update SWL listings.
8/24/21 v2.8.0.223: Fix TXEQ not properly activating (was requiring you to move an EQ slider). 8/23/21 v2.8.0.222 Fix PowerMaster COM port selection 8/18/21 v2.8.0.222: Mod PowerMaster COM 1-9 8/14/21 v2.8.0.222: SWL Search (Right Click on SWL listing to send it to RX2). Scanner (Right Click on Memory or SWL listing to send it to RX2).
8/11/21 v2.8.0.221: Fix Scanner: When you manually click (see blue line in image below) on any memory shown in the scanner window it will pull data from the Memory.xml listing so repeaters memories will automatically load up. Fix: If you Stop the Memory or SWL scanner while its paused, it will stop where it was paused and not go to the next
channel. Add CAT commands for RX2 Pan and Zoom sliders: ZZPF = RX2 Pan slider (similar to ZZPE), ZZPW = RX2 Zoom slider (similar to ZZPY). 8/9/21 v2.8.0.220: Fix RX2 slider issue (for those without VU5K modules installed on a Flex-5000). Download and install 2 times. Select Repair the 2nd time 8/7/21 v2.8.0.220: Fix Pan sliders not
functioning correctly. Update SWL file 8/5/21 v2.8.0.219: Mod RX2 now has its own set of Pan and Zoom silders (they appear when RX2 enabled). Mod N1MM spectrum can now select RX1 or RX2 by mouse clicking into either panadapter OR select RX2 setup->General->User interface->RX2 7/26/21 v2.8.0.218: Fix "SWL Search" listing selection of
VHF stations (i.e. NOAA weather satellite, Marine FM channels, NOAA WX FM channels) and automatically select FM. Properly display VHF SWL listings on the Panadapter. 7/22/21 v2.8.0.218: Mod WFM mode (right click on the FM button) is now 17khz deviation with +/- 20khz 40khz wide audio, to try and decode NOAA Satellite APT. Fix Scanner
Memory Scan, when its paused on a Squelch break and you hit the Memory Scan button to stop the scan. 7/21/21 v2.8.0.217: Fix band button interaction between RX1 and RX2 when using transverters. Open up VU5K 2m module to receive from 128 mhz to 180mhz (not sure how sensitive it is below 144mhz, but it works well up to 163mhz). Update
SWL2 file to add US VHF weather channels and some Marine channels Receiving Local NOAA VHF Weather channel 4 7/20/21 v2.8.0.216: Fix 30m RX2 band button not functioning. Fix xvtr band buttons for RX2. Mod up to 52khz wide RX for both RX1 and RX2 (Flex-5000) 7/2/21 v2.8.0.214: Mod Separate automatic frequency Polling option for each
CAT port (AI). When "Checked" PowerSDR will automatically send a CAT FA and FB to that CAT port when the VFO is changed (i.e. Polling). Example: FA00009915500;FB00007294500; (VFOA = 9.915500 mhz and VFOB = 7.295500 mhz). CAT devices that Poll on their own do not need this box Checked. The CAT device can still send a ZZAI or AI
command to turn this feature ON/OFF remotely on a Port by Port basis. Update SWL file 6/20/21 v2.8.0.213: Mod Antenna Panel for Flex-5000, now shows full RX/TX in SO2R mode: Example 1: Radio 1 = RX&TX on ANT3, Radio 2 = RX&TX on ANT1, Transmit for Radio 1 Example 2: Radio 1 = RX&TX on ANT3, Radio 2 = RX&TX on ANT1, Transmit
for Radio 2 Example 3: Radio 1 = external Transverter RX=XVRX, TX=XVTX/COM (transmit on Radio 1) Example 4: Radio 1 = external Transverter RX & TX = XVTX/COM (transmit on Radio 1) Example 5: Radio 1 = 70cm (VU5K internal option) Example 6: Radio 2 = 2m (VU5K internal option) (transmit on Radio 2) Note: The VU5K module has a
special internal provision to allow use RX2 for full duplex. But external transverters can only use RX1. . .. .. 6/14/21 v2.8.0.212: PM2 PowerMaster II option (not sure if it will work since I dont have one to try). PowerMaster II only has the 34msec data transfer feature unlike the PowerMaster I which has 5 output timing rates and PowerSDR calibration
routines use the 140msec data transfer. 6/9/21 v2.8.0.212: Add PowerMaster Watts and SWR directly on the main console screen (upper left corner). Activate from setup->General->Options->Use PowerMaster for Watts and SWR, and also select the real COM port. 6/7/21 v2.8.0.211: Change BandStack: Left Click on BackStack button adds BandStack
panel to either Panadapter (if meters on right side), or upper right side (if meters on Top bar). Right Click on BandStack button to open separate BandStack panel. All are now capable of Dual BandStack. If you Right Click on the spotter "Callout" button, it will allow you to spot a station from VFOB. Fix: Properly hide the RX2 Band button panel if 2nd
meter is on the bottom right. /28/21: v2.8.0.210 Fix BandStack (Right Click over one of the bandstack frequencies) Lock feature, caused by adding the RX2 bandstack. RX2 freq now VFOB now goes to last Bandstack freq (like RX1 does) 5/25/21: v2.8.0.209 Mod BandStack: VFOA and VFOB Dual BandStack for Flex-5000 with RX2 option. Right Click on
the Add,Sort,Del button to perform those functions on the VFOB BandStack. Left Click for VFOA. Update FCCData callsign file. 5/22/21: v2.8.0.208 Fix Ant panel Lock issue with RX2 and SO2R and fix install issue 5/21/21: v2.8.0.207: Mod: Mouse Wheel Click on BandStack entry (frequency) sends it to VFOB instead of VFOA. Mouse Wheel Click on
Memory sends it to VFOB instead of VFOA (Note VFOB is not setup for Split operation, simplex only). Fix Amp PTT key line issues between VFOA and B with RX2 ans SO2R mode 5/18/21 v2.8.0.206: Fix some mistakes with .205 (and expert mode), and now allow selecting seperate TX KEY lines to your SO2R Amp from both RX1 and RX2. SO2R
checkbox activates this feature (Transmit 2, and the RX2-TX1,TX2,TX3 boxes). Check RX2-TX1 or RX2-TX2 or RX2-TX3 to use that TX key line for your SO2R AMP when RX2 is Enabled and VFOB has the TX button active. In this example the Yellow RCA will Key only when you transmit from VFOB (with RX2 ON) The Red and White RCA will Key only
when you transmit from VFOA (with RX2 ON or OFF) 5/17/21 v2.8.0.205: Mod ANT panel (for Flex-5000 with RX2 and HRFIO Rev34 board) to allow Transmit Ant selection (Transmit 2) for RX2 SO2R. If TX2 is unchecked, works as before. If TX2 is checked you can changeover transmit Antenna when VFOB TX button is checked. VFOA TX = Transmit1,
VFOB TX = Transmit2. Fix RX2 preamp always defaulting to ON 5/6/21 v2.8.0.204: Mod VAC1, Select from 2 saved virtual audio cables configurations (A and B). In this example A is configured for a Digital mode communications link between PowerSDR and Digital mode PC program like FLDIGI or WSJT-X. In this example (below) B is configured for
Local or Remote operation using your PC Speaker and PC Mic connected to PowerSDR. Note: This assumes you set your "Default" Playback and Recording devices to "Speaker" and "Mic" In this example (below) B is configured so any sound your PC would play through its wired speakers would get [mixed] with the Flex radios own Mic (your not using
the PC MIC). Note "Output" is NOT set to the "Primary Sound driver" (like your PC speaker) otherwise you would get feedback if you enable the MON function in PowerSDR. Note: "Stereo Mix" only grabs the line out (green TRS) audio. It will not grab HDMI PC audio or Wireless PC audio. "Stereo Mix" is normally disabled by Windows default. Google
on how to enable it. 5/4/21 v2.8.0.203: Fix RX2 band buttons causing crash on transmit. Add VFO indicators to Sig meters 5/3/21 v2.8.0.203: Fix decimal culture issue (. vs ,) with VOACAP wattage slider. Mod: Band Button panel for RX2 VFOB (Flex-5000 with 2nd receiver option only) but only when the 2nd meter is up on top or up to the right side.
Work in progress _ setup->Appearance->Meter->Meters on Top----------- OR--------------- setup->transmit->Move 2nd Meter 4/30/21 v2.8.0.202: Fix: Allow TCP/IP CAT to properly restart if the connection is dropped rather than closed. Mod: Mouse Wheel Click will now select a DX call, on the Spotter screen, and send it to VFOB (Left Click sends it to
VFOA, and Right Click opens QRZ lookup). If you have a Flex-5000 with RX2 it will also select the Mode. Mod: All Message box sceens will now always appear on top of PowerSDR (to prevent being hidden behind), along with progress bars. 4/29/21: v2.8.0.201: Fix Setup->General->Calibration (which uses WWV to calibrate freq of the radio, in lieu of
using a 10mhz GPSDO). Force display into 4096 Spectrum to avoid issues running in 16384 Hi-Def Panadapter mode that prevented the Calibration from running. 4/28/21 v2.8.0.201: Mod Spotter screen LoTW color code ToolTip description. When you place the mouse over the Color Coded DX Callsign (with LoTW button on and Green), you get the
description of the color code. When the mouse is over the spotter screen, but not over a DX Callsign, you can hit F1 or F2 for help. Update SWL file 4/25/21 v2.8.0.200 ADD: ONLY Flex-5000 with 2nd receiver (RX2): Allow Multiple instances or 2 different PC digital mode programs (example: 2 instances of WSJT-X or WSJT-X and FLDIGI) to operate
simultaneously in SO2R mode. OR simply run 1 PC Digital Mode program on RX2 VFOB, while using RX1 VFOA for anything else (i.e. Rag chew). Fix SPLIT button when RX2 enabled. The Sub VFOA is used as the Transmit SPLIT frequency and must be within the Sample Rate passband. SPLIT will now automatically re-sync the Sub VFOA if its out of
band, OR activate MultiRX then Right click on MultiRX to re-sync it to VFOA. Add The "RX2 VFOB" CAT COM port that simply substitutes RX2 VFOB frequency and VFOTX, for RX1 VFOA when linking PowerSDR to most any PC digital mode program that can select Kenwood TS-2000 as the "radio" (since nobody properly supports the ZZ Cat
commands of PowerSDR) Since the Flex-5000 with RX2 offers "Full-Duplex" you can continue to Receive on 1 PC Digital mode program while Transmitting on the other (provided you have seperate antennas with enough space between and are on different bands so you do not overload the front-end. See full setup down below (search for WSJT-X down
below in the "Digital Modes" section) 4/23/21 v2.8.0.199: Mod "LoTW" to allow for download of VERY VERY LARGE QSO/QSL LOG files (i.e. over 100k and up to over 330k contacts). Automatically generate a "LoTW_OLOG.adi" backup file at the same time it generates a "LoTW_LOG.adi". The LoTW_OLOG file can be used as an Original backup to save
time downloading a large LoTW Log file over again from ARRL LoTW's site. 4/17/21 v2.8.0.198: Try and fix issue where the database does not save changes when you shut down PowerSDR with VOACAP running. Fix issue when VOACAP auto starts at power-up and does not have SunSpot #'s (due to timing) and so draws incorrect MUF map. 4/14/21
v2.8.0.197: Fix Grab & Drag function for adjusting Panadapter & waterfall ratios. Now will work for all screen resolutions. Add: Length timer to 1750hz repeater tone. 4/6/21 v2.8.0.196: Click on "Tune Step", it will turn Dark, and larger step values will act like the small step values (i.e. Steps start at the nearest 0 value) 4/3/21 v2.8.0.196: Mod: TX
Profile now stores Mode. So now if you create a TX Profile for AM, you can save it to automatically select the SAM mode every time you run your AM TX profile. LSB/USB is automatically selected by band. BUT... the Mode will not restore from a TX profile if Setup->Transmit->Remember TX Profile on Mode Change is Checked. 3/28/21 v2.8.0.195:
Update keyboard shortcut pdf (see above). Mod: Right Click and Grab on left side dBm scale to adjust Spectrum Grid Max value (i.e. scale of spectrum), normal Left Click and Grab still adjusts the noise floor (i.e. Spectrum Grid Low value). Now shows actual values for both Max and Min settings. Improve Grab of Panafall adjustment bar. F9=Inc
Spectrum window, F10=Dec Spectrum window Fix: TXEQ 28band GEQ and 9band PEQ preamp values now restore correctly. Update SWL listings file (eibispace.de) 3/25/21 v2.8.0.194: Fix auto save of Panafall (so you can grab the bar to adjust, the next time you boot PowerSDR after you already changed the default proporations of the Panafall).
3/24/21 v2.8.0.194: Mod: Auto save the current positions of the panafall and panafall8020. Fix: Hopefully fix issues with the database not saving changes on power-down. SWL update. 2/28/21 v2.8.0.193: Mod to turn off "Click to tune"cross hairs when over the dBm scale, over the AGC-T green line, or over the Pan/Water bar area. Fix the vertical cross
hair when decreasing the Pan area < 50%. 2/27/21 v2.8.0.193: Mod: Allow adjusting standard "Panafall" mode Pan / Water ratio (From 10% to 93% Pan) by grabing the bar between the Pan and Water. The "Panafall 8020" mode allows from 60% to 93". Mod: "Horizontal Split" Mouse icon when over the bar separating Pan and Water areas. Mod:
"Hand" mouse icon when over the left side dBm scale showing that you can grab and pull up/down for adjusting Signal floor levels in the Pan. Mod: "Hand" mouse icon when over the AGC-T green line to show you can grab and pull up/down for adjusting the AGC-T level (right click on AGC-T text to activate) Update: SWL file 2/26/21 v2.8.0.193: Mod:
Allow adusting "Panafall8020" (used to display active world map) Pan / Water raio (Grab bar between Pan and Waterfall and drag up/down or F9-F10 keys. (From 60% to 93% Pan) 2/21/21 v2.8.0.192: Fix: Properly remember band changes related to TX Profiles 2/14/21 v2.8.0.191: Fix Grayline dark area not filling correctly. Correct VFO "Dial"
alignment to properly match frequency (due to imperfect dial image). Fix antenna amp TX1,2,3 help. 2/13/21 v2.8.0.191: Fix: Right click on SWL listing (on the Panadapter) was not opening up a google search properly. Update SWL data 2/12/21 v2.8.0.191: Mod 2nd TX meter smooth out the movement. And try to prevent a jumpy SWR 2/6/21
v2.8.0.190: Update FCCDATA file and SWL files. fix: FULL installer will now copy over FCCDATA file. Quindar tones option (setup->keyboard) 1/25/21 v2.8.0.189: Add Voice Keyer VK1 [F5], VK2 [F6] buttons (in addition to the Reply [F3] and CQCQ [F4] buttons). Use WAVE to make recording. Moved "1750hz" repeater Function button to [F7] 1/23/21
v2.8.0.188: Add "1750hz" button (and F7 key) for repeater access. Modify VFO mechnical dial with an actual dial image (setup->Display->VFO Dials 1/18/21 v2.8.0.187: Mod voice keyer "Reply" button can now be activated by F3 key, "CQCQ" by F4 key. If you "check" Setup->General->Hardware Config->Auto Focus PowerSDR, then simply moving
your mouse pointer back over PowerSDR console will allow you to use the keyboard for PowerSDR (if you have multiple Windows programs open) See updated keyboard map pdf for all keyboad definitions 1/14/21 v2.8.0.186: Mod Scanner Low / High Band edges are now saved in the database. 12/15/20: v2.8.0.185: Fix CW Spots now appear directly
over the spot. XIT Flip (right click on XIT) added to DJConsole button list. 12/4/20 v2.8.0.184: Fix CAT port preventing duplicate COM ports even when not selected. 12/3/20 v2.8.0.184 Fix N1MM not taking CW pitch shift into account. 12/02/20 v2.8.0.0.184: Fix N1MM Spectrum only allows for KHZ for the Low/High frequency of the spectrum, so
needed to align the spectrum output to the nearest khz low/high values. Now the N1MM freq indicator matches the spectrum correctly. 11/30/20 v2.8.183: Fix DttSP auto restart when minimized. 11/29/20 v2.8.0.183: Fix SWR Scanner will retry if the SWR gets erroneous reading during the scan (prior to this you would see an occational SWR=25
reading between normal SWR readings. 11/27/20 v2.8.0.183: Mod now N1MM spectrum and DttSP auto restart work with PowerSDR minimized 11/25/20 v2.8.0.182: Fix full installer issue (Wrong folder name). 11/24/20 v2.8.0.182: Fix TCP/IP CAT from turn off when a remote connection if cut rather than closed. Mod: Noise Blanker (setup->DSP>Options->NB or just right click on NB console button). NB1 and NB2 operate from a slightly different perspective. Modifying NB1 to account for different DSP RX buffer sizes. Trying to see if I can improve on it. 11/21/20 v2.8.0.181: Fix setup->Appearance->General->Console Maximize not restoring properly. Fix setup->Cat Control->Rotor Control
now can be used with for direct control of Hy-Gain antenna rotor controls (no need for DDUtil). _____________________________________________________________________________________________ PowerSDR ke9ns v2.8.0.172 through v2.8.0.180 11/16/20 v2.8.0.180: Add Multiplex CAT COM ports (up to 5). Allows you to Name each program your connecting
to. This can take the place of DDUtil in many circumstances. Rotor Control still requires DDUtil. If you run DDUtil, you will need to disable any COM ports controlled by DDUtil. 11/8/20 v2.8.0.179: Mod "TX WaterID" call sign image resolution improved slightly. 11/2/20 v2.8.0.178: Fix PAN ZZAU/ZZAD not working for JogWheelA (for DJConsole units).
11/1/20 v2.8.0.178: Mod: PAN feature now works with DJConsole JogWheelA and ZZAD/ZZAU CAT command (Panadapter stays in one place while the bandpass RX/TX moves around). Update SWL file 10/24/20 v2.8.0.177: Fix CAT TCP Server to ignore and LF characters. 10/23/20 v2.8.0.177: Mod CAT TCP Server. Indicator (upper right) to show when
external TCP connection made. Right click on "ON" checkbox to open up monitor screen to display all CAT communication between TCP and PowerSDR. 10/22/20 v2.8.0.177: Add CAT TCP server to allow CAT command exchange via Ethernet. Open a TCP connection to your IP:PORT and you can send and receive CAT commands and CAT data. also,
Update SWL.dat file per eibispace.de 10/17/20 v2.8.0.176: Fix LoTW sometimes unable to do a full QSO log download. Fix DXLOC.txt DXCC code for Germany (causing Germany to show as a needed DXCC entity when it was not) 10/15/20 v2.8.0.175: Update FCCDAT.dat and download location link, and SWL.csv files. Fix a compile issue. 9/13/20
v2.8.0.174: Modify: Some windows are now fixed in size so they cannot be accidentally resized incorrectly (i.e. Setup, Mixer, ATU, ANT, XVTR) 9/11/20 v2.8.0.173: Fix TX EQ "Both" checkbox now clears if using 3 or 10 band EQ. Update SWL file 8/22/20 v2.8.0.172: Add WBHF RX capability. Update SWL file
_____________________________________________________________________________________________ PowerSDR ke9ns v2.8.0.155 through v2.8.0.172 8/22/20 v2.8.0.172: Fix Local Antenna Weather (set location: Spotter->Lat and Long), it now tries NOAA weather first, and then openweather. 8/1/20 v2.8.0.171: Fix TXEQ not restoring properly when changing
TX profiles (preamp gain not included). Fix some BandText (setup->general->Update BandText). Update SWL listing 7/10/20 v2.8.0.170: Add CW RX filter save without adjusting for CW Pitch option(Setup->General->Filters->CW RX filters no shift checkbox). Right Click on CWL/CWU or Low/High fields to open Filters menu. 6/24/20 v2.8.0.169:
Update SWL file and FCCDATA callsign file. Fix lag issue when right click on QuickAudio Play button (when manually selecting a QuickAudio file to play back over the air) OpenDialog issue. 6/2/20 v2.8.0.169: Mod: XIT (Right Click on XIT button to toggle between +hz/-hz). Fix vfo changing freq when changing between AM/SSB on swl 11m 5/19/20
v2.8.0.168: Fix 3 band EQ setting and proper EQ settings saved to your TXprofile. 5/17/20 v2.8.0.167: Add Local Ant Weather for most any Location. Most of USA still uses NOAA weather.gov. Other locations now use openweathermap.org & mapquest for elevation. Based on your Lat/Long found in Spotter (use maps.google.com, right click->whats
here, to find your Lat/Long). Fix slider issue with auto grid/wtr/AGCT sliders not loading up automatically Example Lat/Long for Paris: 5/9/20 v2.8.0.166: Fix TXProfile crashing when changing profiles. Add SWR data save to SWR_PLOTS folder in .csv format (for each SWR scanner run). Right click on SWL SCAN button to open folder. Update SWL.dat
file 5/6/20 v2.8.0.165: Fix all EQ's now saved to the TX Profile. Fix PEQ Octave value not saving correctly. 4/26/20 v2.8.0.164: Fix "MUTs" (hold mouse over MUT button for more info) now also mutes Powered and RCA speaker output on 5000. Fix 3band TXEQ causing 28band EQ sliders to disappear. 4/25/20 v2.8.0.164: Fix: 28band TXEQ not turning
on until you touch a slider. Add: You can combine the 28band GEQ and the 9 Band PEQ together. Fix: Spotter screen accepts spots from CWSkimmer (i.e. localhost:port) with the port value being what you set the port value to in CWSkimmer. You can use the URL: "localhost" or "127.0.0.1" Update SWL.dat file. 4/18/20 v2.8.0.163: Fix Update button.
(SSL vs XMLreader issue). Update SWL.dat file 4/18/20 v2.8.0.162: Fix TXEQ's now have their own preamp sliders (10band,28band,9band). 4/17/20 v2.8.0.162: Add 9-Band Parametric EQ in addition to the 10-Band and 28-Band Graphic EQ options. Not final GUI interface, but working. 4/12/20 v2.8.0.161: Mod: 28 band TX EQ is now 1/3-Octave bw
per Band slider. The original 10 band TX EQ and RX EQ both continue to use 1-Octave bw per Band Slider. 4/10/20 v2.8.0.161: Update reply, cqcq, pan, zoom, and 3d buttons. Update FCCDATA.dat callsign database file, Update SWL.dat file, modify gen/bal rx2 routine. 4/7/20 v2.8.0.160: Fix zoom slider crash when running very high frequencies
(XVTR). 4/6/20 v2.8.0.159: Fix Map Grayline, Sun, Moon somtimes not functioning when turned OFF and back ON. Improve moving Console panel around with Title bar disabled (you can now Left click on an open area of the Console and drag the console around, or right click on lower right square to minimize Console). 3/31/20 v2.8.0.159: Fix
Grayline. Setup->Appearance->Display->GrayLine (Dark-Bright) slider to adjust actual darkness of the Grayline area of the Map (instead of drawing over the Grayline area on top of the Map), and Map (Dark-Bright) slider to adjust brightness of the Map (outside of the Grayline area). Allows you to see under the Grayline area with more clarity. Update
SWL listing. 3/28/20 v2.8.0.158: Fix Waterfall Low & High level thresholds for SWL bands (not using/saving database values). Add F2 Video for TNF usage (Tracking Notch Filter). Tweak the Move/Size routine when the Title Bar is disabled. Tweak VFO Dial placement. Tweak GEN/BAL test. Fix "Check Update" 3/24/20 v2.8.0.157: Fix Bleed around
COMBO meter when RX/TX menus turned off. 3/22/20 v2.8.0.157: DX Spotter listing can be masked to show RX1 and/or RX2 bands only. Currently the list will show empty lines masking the filtered bands, but the list updates on the fly as you change bands. 3/21/20 v2.8.0.156: Allow removal of Title Bar (setup->Appearance->General->Console Title
Bar off). Grab symbols in lower right corner to move and size console. Right Click on START/STOP button to CLOSE PowerSDR Update SWL listing. Fix check for updates 3/17/20 v2.8.0.155: Mod Memory screen now has a "Scan" column checkbox. Scanner screen will now check for the "Scan" checkbox, and skip (ignore) any unchecked memory
channel when you do a "Memory Scan". This will help if a particular memory channel (frequency) has noise tripping the squelch, but is grouped with other memories you wish to scan. An "X" is placed on the Scanner Memory list to indicate a Memory channel to be skipped from the Group. If you update the Scan checkbox(s) on the Memory screen, you
must retype the group name in Scanner "memory Group to scan" box. . _____________________________________________________________________________________________ PowerSDR ke9ns v2.8.0.144 through v2.8.0.154 3/17/20: v2.8.0.154: Fix Bandstack flashing 3/13/20 v2.8.0.154: Mod Meters. Allow functioning VFO Dials with Meters on Top
ANF,NR,NB,NB2 deactivates during DIGU/L modes, but now automatically reactivates when switched out of DIGU/L mode. 3/10/20 v2.8.0.153 Mod: Meters. Right Click over dBm text area to toggle RX/TX Meter Menus ON/OFF. Right Click on Meter itself to Open: Setup->Appearance->Meter->Meter on Top, to move Meters to Top of Console.
BandStack panel will automatically move (right click on "BandStack" text, top center of Console) 3/5/20 v2.8.0.152 Mod: Slight Analog Meter improvement (more of a traditional meter style).Left Click on top meter to cycle though meters, setup->Appearance->Meter-> to change colors. If you want the meter to move identical to a physical meter lower
the setup->Display->Multimeter->Analog Refresh time. Update SWL listing. 2/19/20 v2.8.0.151 Add: Audio Mixer: You can now Mix PC audio and Flex MIC audio together (Setup->Audio->VAC1->Mix VAC1 and MIC audio checkbox.). Enable VAC1 and make sure to uncheck "Allow PTT to override..." box. Your PC audio output device must be the same
as the PowerSDR VAC1 Input device. 2/17/20 v2.8.0.150: Mod: Auto reduce frame rate when in 3D mode. 3D mode Panadapter size reduces when in Panafall mode. Allow Color select and Transparency (Alpha) for 3D. Can be combined with Pan fill. 2/14/20 v2.8.0.150 Add: 3DPanafall (based on Mark's WS7M idea). Real-time Panadapter spectrum data
is presented at the front, and older data (History) is shift back into the screen (with a 3D effect). The oldest data falls off the very back of the display. The History length depends on the FPS setpoint. Click on blue 3D button on console to toggle. Still tweaking. Requires more CPU horsepower in 3D mode. Best viewed in hi-res mode, with RX1 only,
Map & Waterfall OFF. Although you can combine Waterfall and 3D pan and even RX2, I am not sure how well things will perform. (Left:) click to enlarge,--------------- (Right:) Click to watch video in operation) ... 02/8/20 v2.8.0.149: Update SWL file, Update FCCDATA.dat, Update DXLOC.txt, Add "N2MDX 3D Carbon" skin. 01/17/20 v2.8.0.149 Fix: I2C
MCP23017 8bit address is 0x46 (A2=0, A1=A0=5v) 8bit address list for FlexWire output: 0x40 HERO's preselector 0x42 Band selector output for PCA9534 8bit I2c chip (2200m - 20m) 0x44 Band selector output for PCA9534 8bit I2C chip (17m-6m) 0x46 Band selector output for MCP23017 16bit I2c chip (2200m-6m) 0x48 Not used 0x4A LDMOS Amp
Filter board selector (w6pql current design) 0x4E LDMOS Amp Filter board selector (w6qpl old design) 0x4C UCB (Universal Control board) PCA9555D Relay selector (part of the Xvtr panel) See page: k3tuf.com/FW.html , for info on FlexWire and UCB 01/15/20 v2.8.0.149 Fix 28band eq disabling (reverting back to the 10band) when adjusting the
preamp slider 01/14/20 v2.8.0.149 Add: SWL bands to RX2 band listing 01/11/20 v2.8.0.148 Mod: N1MM by adding a FPS control. You can slow down the data transfer if your having troubles. (Setup->General->User Interface->FPS) 01/09/20 v2.8.0.147 Mod: DJConsole ZZMO command toggles between MON OFF, MONpr, MONps. Fix I1C 0x20
address datafor MCP23017 IC 01/08/20 v2.8.0.146 Mod: CAT ZZMO0 = MON off, ZZMO1 = MONpr, ZZMO2 = MONps (flex3000/5000 only). Mod: remove dead space on top of TXWaterfall ID image. 01/05/20 v2.8.0.145: 12/23/19 v2.8.0.144 Add: "Wait on Squelch Break" option in Scanner. Pauses on active channel and waits until channel is clear
before continuing scan. _____________________________________________________________________________________________ PowerSDR ke9ns v2.8.0.130 through v2.8.0.143 12/22/19 v2.8.0.143 Fix: Scanner, FM not reacting to Squelch (Squelch handled differently in FM mode). Required modifying DttSP. Update SWL listing. 12/20/19 v2.8.0.142: Fix Scanner,
Low-Hi not pausing (it was just stopping) on sql brk. 12/18/19 v2.8.0.141: Add: Left Click & Grab left side of Panadapter (over the dBm values) to move the Panadapter floor up/down in the window (this moves the auto pan slider in setup->Display). Fix issue of Grayline not appearing when turned Off and back On. Add I2C 0x20 band data output
12/15/19 v2.8.0.140: Add Channel OFF/ON checkbox for blue channel guides.(setup->Appearance->Display->Channel Display). Channels still appear in the BandText display area (and you can right click on the BandText display to show all information within the Pan). Also added 60m channels to SWL2 listing to see channels without the blue channel
guides. 12/10/19 v2.8.0.139: Fix TX WaterID, start transmit TEXT quicker by removing dead space under text. Fix Ant panel selection, for Flex-1500 by adding missing SWL bands to the "Expert" mode (just like the Flex3000/5000). 12/05/19 v2.8.0.138: Add I2C band data for all HF Ham bands 0x42 & 0x44 (setup->General->User Interface-> I2C Band
output) 0x42: 2200m=1, 630m=2, 160m=4, 80m=8, 60m=16, 40m=32, 30m=64, 20m=128, 0x44: 17m=1, 15m=2, 12m=4, 10m=8, reserved=16,32,64,128 This works directly with the PCA9534 I2C 8bit port to drive relays. Mod: Add direct link to open "FlexWire" I2C 0x4C relay select panel (UCB Configuration and Setup screen) from the XVTR
screen. Add: tooltips explaining operation, over the "FlexWire" buttons Mod: I2C AMP band select 0x4E to add 0x4A (alternate rev2 w6pql filter board band selection). Updated SWL listing eibispace.de 11/12/19 v2.8.0.137: Add "Tune Step" now auto saves separate values for CW mode vs all other modes (for Mouse Wheel), this includes saving
seperate "Tune Step" values Alt 1 & 2 for the PowerMate Knob (setup->General->User Interface) 11/9/19 v2.8.0.136: Add "Loop" checkbox to Scanner lo-hi frequency scanner (Memory & SWL scanner already looped automatically). Fixed issue where SWR and lo-hi freq scanner always would "pause on squelch break" ignoring the checkbox. Updated
SWL.txt file (from eibispace.de) v2.8.0.135: Added slider for AGC-T offset adjustment (setup->Display->AGC-T line adj) allowing you to set where you want the AGC-T green line to appear for a particular AGC-T value with respect to the signal on the pan 10/14/19 v2.8.0.134: Add Visual AGC-T indicator on Pan. Right Click on "AGC-T" text just above
the slider to toggle ON/OFF. Left click on the AGC-T text just above the Panadapter Green line and pull Up/Down (right click on it to turn if off). If you pull the AGCT line down (AGC-T towards 120), but you normally keep the Panadapter noise floor very low on the screen (using the setup->Display->auto grid level slider), the dBm scale will adjust and
move the noise floor up to make room by moving the auto grid level slider to the right. Also the AGCT line will automatically adjust position relative to the noise floor if you have the Setup->Display-> auto Wtr/Pan checkbox ON AGC-T is the PowerSDR version of an "RF Gain" control. AGC-T is the "Maximum Gain Threshold" of the AGC (with the AGC
mode: slow, med, fast, adjusting the Attack, Delay, & Hold time of the Gain). Still playing with the position of the AGC-T line (Panadapter signal dBm vs AGC-T "Max Gain Threshold" dBm). And I have not tried this on the Flex-3000 or Flex-1500 yet). Updated the SWL listing (from eibispace.de) 10/6/19 v2.8.0.133 Modify: Right Click on 0.5x, 1x, 2x, 4x
Buttons, for 100x, 10x, 20x, 40x Zoom Above (click to enlarge): 100x zoom of FT8 segment (50hz wide overlapping signals) on 40m @ 192kSR with Hi-Res Panafall and PolyPhaseFFT enabled 10/5/19 v2.8.0.133 Modify Continuum mode: Add S-Meter dBm data to file (as well as the orignal peak dBm value found in the Panadater), and add UTC
date/time as well as Local and MJD. Save file automatically every hour (if you leave the logging feature on) Modifed ZOOM slider: 0.3x to 100x (was 0.4x to 10x). Just make sure to enable setup->Display-> hi-res Panafall (and possibly polyphaseFFT if you dont mind the lag) for best display results. @48kSR = 10hz / div., @ 192kSR = 25hz/div. Hold
mouse steady over zoom slider to see Zoom Factor 8/19 v2.8.0.132: Add MUT button function: Mouse Wheel Click (push down on mouse wheel) on MUT button to toggle between MUTE of your Flex speaker and MUTE of your PC speaker. 6/26/19 v2.8.0.131 Fix PowerSDR shutting down when your UAC UI asks for "Consent" and blanks the screen.
Add F2 video help for ESC (Enhanced Signal Clarity) button. 6/23/19 v2.8.0.130: Fix ESC panel to remember its location on the screen and make it easier to reduce its screen size. 6/19/19 v2.8.0.130: Fix waterfall frequency grid of RX2 during transmit. Update SWL file 6/12/19 v2.8.0.129 Mod: IDTimer 30min (Setup->general->Hardware Config>30min ID Timer) option. Add: "F2 key" Video Help for IDTimer (when PSDR in focus and mouse over the IDTIMER). Fix mouse wheel vfo scroll lockout if you change the CQ timer value or TX bandwidth Low or High. Mod to allow PowerSDR to close when Windows does a Shutdown (setup->general->hardware config-> Allow Windows Shutdown).
_____________________________________________________________________________________________ PowerSDR ke9ns v2.8.0.115 through v2.8.0.128 5/16/19 v2.8.0.127: Mod SpaceBar PTT (2 options now) Hold or Latch PTT with the SpaceBar. Update SWL listing. 5/10/19 v2.8.0.126: Fix PowerSDR issue not properly updating (saving) your database when
closing PowerSDR. 5/7/19 v2.8.0.125: Add Hi-Res Panafall option (Setup->Display->Hi-Res PanaFall). Standard PowerSDR shows max of 4096 points, "Hi-Res" mode shows max of 16384 points Because of the finer detail, you may see more signals on the screen, but also more Spurs. (Note: possible higher CPU usage) Most helpful when running at
192k SR Will also display finer detail on your Transmit audio in the Panafall. Just make sure to lower the Setup->Display->avg and update times to speed up the waterfall. "Enable PolyPhaseFFT" shows maximum detail, but has big latency. (LEFT: standard 192k full zoom, RIGHT: Hi-Res 192k full zoom) at 10x zoom Click on image(s) to see full size. _
(192k Hi-Res: Olivia 8-250 and FT8 signals at 10x zoom) 5/4/19 v2.8.0.124: Add SpaceBar PTT (Push-To-Talk) operation (Setup->General->Hardware Config->SpaceBar PTT). When Checked will TX radio when SpaceBar held down (PowerSDR must be in focus), and return to RX when SpaceBar released. Note: If you run PowerSDR on its own Monitor,
you can also run PowerSDR Auto Focus Option (Setup->General->Hardware Config->Auto Focus). Add: Spot Age can be adjusted from 3 - 59 minutes (Spotter ->Spotter Settings->Spot Age). Update FCC callsign database for LoTW states. 5/1/19 v2.8.0.123: Add FT4 to BandText (setup->General->Options->Update BandText). Right click on BandText
(found just below the VFOA or VFOB to see BandText in the Panadapter. Add FT4 mode and freq to Spotter screen. Update SWL listing 4/19/19 v2.8.0.122 Fix: CQCQ wait timer while using VAC1, and allow you to use a PC MIC over VAC1 to record voice keyer audio (like Reply, and CQCQ). Fix: Autofocus works, but you probably would only use it if
you have a 2nd monitor and dedicate PowerSDR to its own monitor. 4/18/19 v2.8.0.121 Fix lag issue 4/17/19 v2.8.0.121 Fix CQCQ wait timer. 4/16/19 v2.8.0.120 Mod: CWX Macros1-9 can now be triggered by F1-F9 function keys (with CWX form in Focus) 4/15/19 v2.8.0.119 Fix: Flex-5000 ANT Console display not updating correctly in "Expert" Mode
(RX2 Ant not updating unless RX2 was ON). Mod: SWL_Search now toggles ON/OFF the Search window & SWL Spots on Pan. 4/14/19 v2.8.0.118 Fix: CQCQ wait timer to end playback via Mox/PTT or CQCQ button click during repeat wait time. Add colors to Reply and CQCQ buttons (Blue=off), transmit (Red), and wait period (Orange) 04/13/19
v2.8.0.118 Firmware Update: Expand 12m Norway, Add 60m TX for Hungary, Greece, France, EU Travel, Mod 40m Hungary. Add: Auto Focus for PowerSDR console screen: Setup->General->Hardware Config->Auto Focus PowerSDR: When checked, this will put PowerSDR back into Focus (sending keystrokes to PowerSDR) whenever the mouse is
over the PowerSDR console screen. If you also check the "Always on Top" checkbox for any PowerSDR sub-form (i.e. Setup, Memory, CWX, Scanner, Spotter, SWL Search, Bandstack), then moving the mouse over a sub-form will Auto Focus between the main PowerSDR console and its sub-forms. 04/09/19 v2.8.0.117 Mod: DEXP turns off during
Quickaudio playback (EQ,DX,CPDR already turn off). Mod: Rec/Play ID box will uncheck after Quickaudio playback. Update: SWL file listing ( 04/7/19 v2.8.0.116 Add: 630m button to the band buttons for RX1. This mod does NOT alter your transmit capability, it just takes you to 472khz. (search this webpage (CTRL+F) on "630m" for more info.).
PowerSDR now compiled under Visual Studio 2019. 04/2/19 v2.8.116 Add: "CQCQ" voice keyer repeat timer (0=no repeat to 9 sec). Go to Wave->CQCQ to make recording. Click "CQCQ" button to Start & Stop voice keyer. PTT or VOX to Stop playback and break in 03/27/19 v2.8.115: Fix CW Visual TX while in Split mode. Update SWL file
_____________________________________________________________________________________________ PowerSDR ke9ns v2.8.0.109 through v2.8.0.114 02/28/19 v2.8.0.114: Fix spotter ISS location SSL cert issue 02/26/19 v2.8.0.113 Fix: local weather min/max Logitude values 02/19/19 v2.8.0.113 Fix: LoTW Https Server SSL/TSL issue. Fix issue with Setup>DSP->Options for RX2 not following RX1. Update FCC callsign database, and SWL files 02/03/19 v2.8.0.112 Add: Scanner can now scan for SWL groups. Type in full or partial SWL name to select a SWL group to scan. You can now scan groups of SWL, MEMORY, or Bandstack. (with or without squelch break). Updated SWL2 freq list 01/28/19
v2.8.0.111 Add: VOX slider control to Digital panel. Update SWL listing 01/19/19 v2.8.0.110 Fix: saving 28 band TXeq in a TXProfile (only for new Factory defaults databases) 01/13/19 v2.8.0.109 Fix: "DttSP Auto Restart" feature causing issues when RX1 is in water with RX2 enabled. 01/02/19 v2.8.0.108 Add: Setup->Display->Avg Pan Move. When
checked, will try to keep the Panadapter Display signals intact when you scroll frequencies (left/right) the band with the AvgP (signal averaging for just the Pan), or AvgB (signal averaging for Both the Pan and Water) enabled. Just makes it easier to keep track of signals as you scan around the band. Normally when you move left/right the band, the
display signals drop as you scroll with Averaging turned ON. 12/29/18 v2.8.0.107: Fix timing issue between the CAT Serial COM port, and FlexControl Serial COM ports at launch, if DDUtil running. 12/28/18 v2.8.0.107: Update: SWL listing to add Clear Channel AM Broadcast stations for all of North America (CA,MX, US). Fix mistake in .106 (FM
panel not visible). Fix mistake in Memory screen. 12/24/18 v2.8.0.106: Add (Setup->DSP->Keyer->Visual display of CW, and also under CWX panel). Displays your CW transmission (CWL or CWU) on the Panadapter and Waterfall. Update SWL (eibispace.de) 11/21/18 v2.8.0.105: Update FCCdata.dat (for the DX spotter and LoTW), SWL.dat (from
eibispace.de), and BandText for US region (click Setup->General->Options->Update BandText button). Antenna panel icon lights up on TX 11/11/18 v2.8.0.104: Fix RXonly PTT function for Flex-1500 and Start/Stop button with RXOnly checked 11/8/18 v2.8.0.103: Flex Firmware update (1500,3000,5000): Add 60m for China, Italy, Hungary (beyond
the last firmware update), Remove Russian 27mhz TX. Will not affect your MARS. Fix: VAC PTT bypass not working with VOX enable 11/4/18 v2.8.0.102: Mod to allow VOX with VAC1 and VAC2 (Flex-3000, Flex-5000 only) 10/31/18 v2.8.0.101: Fix Faults caused by adding the "Save drive per mode" feature. 10/23/18 v2.8.0.100: Add: "Day" indicators
(bottom of panadapter area but above the waterfall) as part of world tracking map. 10/11/18 v2.8.0.99: Add:Setup->Transmit->Save Drive per Band and per Mode. When checked saves your Drive Max setpoint and Driver slider per Band and Mode. 10/08/18 v2.8.0.98: Add: Setup->General->Hardware config->Auto Start PowerSDR. "Start" PowerSDR
running immediately after launch and loading. Fix: DttSP Auto Restart preventing Scanner->Sig Ident from working. 10/07/18 v2.8.0.97: Fix: DttSP Auto Restart during transmit. Add: Setup->General->Options-> Wheel Reverse to reverse the Mouse/Trackball wheel frequency direction. Fix: voltage RED when over 14.96vdc. Update: SWL and DXLOC
files. 09/28/18 v2.8.0.96: Add setup->general->hardware config->DttSP Auto Restart. When checked senses when the DSP freezes, and automatically restarts. (Note: Freezing occurs from DPC Latency issues) 09/24/18 v2.8.0.95: Fix Clicking on blue "Spotting" button freezing PowerSDR (when DX Spotter is set to automatically run at power up).
09/18/18 v2.8.0.94: Fix NOAA space weather changeover to https tls1.2. Update the FCCDATA.dat callsign database, and SWL.csv shortwave listing files 09/03/18 v2.8.0.93: Fix issue loading up SWL list at the same time loading up dxloc file. Update SWL listings 08/27/18 v2.8.0.92: Fix 17m bandtext for IARU 1 08/25/18 v2.8.0.92: Fix DX spotter
screen display (speed up laggy display update after I switched to RTF- Rich Text Format). Update SWL and DXLOC files. 08/21/18 v2.8.0.91: Fix LoTW checking for the same callsign on different bands and modes. 08/06/18 v2.8.0.90: Fix Setup->General->Hardware Config-> RX Only checkbox not remembering. 08/03/18 v2.8.0.89: Modify: checkbox
to ignore Beacon Spots. 08/02/18 v2.8.0.88: Modify: LoTW color Gray for Beacons (dx spots with /B as an ancillary prefix) 08/01/18 v2.8.0.88: Add: LoTW USA 50 State checking (by band) in addition to DXCC & Dup checking. Also displays the US State on the DX Spotter screen. Fix: DXCC checking for entities with leading zero's and being properly
checked.. Added: FCCDATA.dat file (in database folder) with Callsign/State (based on EN.dat FCC file, but much smaller) 7/30/18 v2.8.0.87: Fix: dx spotter beam heading and spots on world map for cultures (i.e. Europe) with , instead of . as floating point separator. 7/28/18 v2.8.0.86: Right Click on LoTW button will now download QSO & QSL
incremental updates to your master LoTW LOG file (downloads which usually take only a few seconds). Incremental updates are based on the last date your LoTW_LOG file was updated. A full LoTW LOG download only takes place if PowerSDR cannot find the LoTW_LOG.adi file in the database folder. Full LoTW LOG downloads can take up to a few
minutes to download. 7/21/18 v2.8.0.85d: Increase LoTW download time limit, speed up spotter display 7/19/18 v2.8.0.85: Fix some LoTW things. Right click on GrayWtr menu item to toggle Pandapter Fill ON/OFF 7/12/18 v2.8.0.84: Allow multiple DX spots on FT8 frequency(s) since people are spotting on the base FT8 frequency(s). Add LoTW
database download for DXCC spotting (for those with LoTW accounts). Right Click on CallSign box to open a LoTW password box. This is the password you would use on First time you use LoTW button it will download your QSO database from LoTW server (Right Click on LoTW button before Left Click, will force a new QSO download from LoTW
server.) DX Spots appear: Purple for NEW dxcc entities (no band), Light Purple if you need dxcc entity for this Band, Green if Station confirmed on this Band, Light Green if Station is confimed but on another Band, Yellow if Station confirmed on another Band, but their dxcc entity confirmed on this Band. Pink if you have this Station on this Band, but
unconfirmed, LightPink if you have this Station on some other Band but unconfirmed. Orange indicates you have this Stations dxcc entity confirmed but not this actual Station. 6/3/18 v2.8.0.83: Add I2C bus software controls for SS AMP (see . Fix bandtext for IARU3. Update SWL list (from eibispace.de) 5/29/18: v2.8.0.82: Fix: Forgot to add the new
Firmware to the Full Installer. 5/26/18: v2.8.0.82: Firmware & BandText Updates: IARU2: gets USB Caribbean Disaster Emergency channels which also show up in the bandText and SWL listing 7.453.5, 7.850, 13.998, 14.415, Belgium: 160m 2mhz, Netherlands: gets IARU1 60m. But all Flex-1500, 3000, 5000 radios get a firmware update. The
firmware update will NOT alter Mars radios. Make sure to Click on the Setup->General->Options->Update BandText button afterwards Also added the IARU1/2 60m band indicators (and bandtext) to the US channels so you can see the overlap (with Canada soon to get access to both US channals and the IARU1 mapping. You can clearly see the Ch 3
overlap 5/25/18 v2.8.0.81: Fix mistakes in bandtext 5/23/18 v2.8.0.81: Add DTMF keypad tones for those using Repeaters (Must be Transmitting. Either Setup->keyboard and click and hold a button, or from the focused keyboard ALT + key 0-9 and * and # ) 4/23/18 v2.8.0.80: Modify: ToolTip's stay active for 12 seconds (instead of 5) if the mouse
remains hovering over the target. 4/17/18 v2.8.0.79: Modify: Quick "SPLT" button feature: Right Click toggles +/- 1khz in CW (+/-5khz in SSB). Updated SWL file. Updated BandText, Updated some Turf stuff. 4/12/2018 v2.8.0.78: VFO Lock can optionally toggle between VFOA, VFOAB, VFOB. (Setup->General->Options->VFO Lock A/B) 4/8/2018
v2.8.0.77: Fully automatic Waterfall and Panadapter levels by the "Setup->Display->auto wtr/pan" checkbox (this in addition to the semi-automatic Left and Right Click on the "Auto Wtr/Pan Lvl" button found on the console screen). 4/7/18 v2.8.0.76: New Quick "SPLT" button feature: Right click to automatically turn ON and toggle between a VFOB
TX of +5khz or -5khz split from VFOA. AND: Setup->Display->Split TX Listen checkbox will automatically set the sub-receiver (MultiRX button) to the TX freq during the Split. Update SWL listing (from eibispace.de) 03/27/18 v2.8.0.75: Add DX spotter world map Brightness control (setup->Appearance->Display->Map) 03/24/18 v2.8.0.74: PowerMate
Knob now has 2 alternate Tune Steps (push Knob to toggle between steps). Add Save state of Voacap (on/off). Fix DXLOC file not fully loading up on startup from a saved ON state. 3/21/18 v2.8.0.73: Now Saves the State of the DX spotter (on/off), and DX Spotting World Map (on/off). If either is running when you power down PowerSDR, they will be
"ON" again at Startup 3/19/18 v2.8.0.72: Fix mistake saving changes to TX profile even when auto save is off. Fixed corruption that occured to Skin ke9ns_world 3/14/18: v2.8.0.71 Recompile. 3/11/18 v2.8.0.70: Fix reduce data size for recording Continuum data 3/10/18 v2.8.70: Add "Continuum display mode" Right click on "Continuum" to toggle
recording data in .csv data file (dBm vs time, and Ant bearing, if setup with DDutil), Files saved in database folder (right click on TXWaterID callsign box). Add MJD time to continuum csv file output 3/8/18: v2.8.0.69: More BandText updates and SWL2 file updates. 3/6/18 v2.8.0.69: Update BandText file. Update SWL file 2/21/18 v2.8.0.69: Add: Pan
Fill Gradient option (setup->Appearance->Display->Pan Fill Gradient). The Fill Alpha still works in Gradient mode, but not the Fill Color. Gradient mode goes from Blue to Violet 2/13/18 v2.8.0.68 Fix Drive Max limit to 100. And Update the SWL file (from eibispace.de) 2/9/18 v2.8.0.68: Add Transmit Drive Max value: setup->transmit->Drive Max, sets
the max value of TUNE and DRIVE allowed (for those with low drive SS Amplifiers). It does not verify max watts out, just the drive and tune levels. 2/2/18 v2.8.0.67: Fix: ke9ns6_World, Ke9ns3_spot, and ke9ns4_plain skins causing "out of memory" fault 2/1/18 v2.8.0.67: Add Antenna rotor control (set manual beam heading, and read current antenna
position) from Spotter window. 01/28/18 v2.8.0.66: Mod: BandText to Pan turns off DX,SWL,MEM spots on Pan to avoid mess 01/27/18 v2.8.0.66: Fix SWL Search mistake,Add color and transparency control for BandText in Pan (setup->Appearance->Display->Grid and BandText) Add:Right click on VFO BandText area to toggle BandText in Pan on/off.
Fix "rx only" checkbox add 40m PSK to BandText (so Click on the setup->General->Options->Update BandText). Please email with any BandText additions or corrections 01/26/18 v2.8.0.66: Add Display "Panafall8020" (80%pan - 20%waterfall) for RX1 only. Add BandText directly onto Pan Display area (Spotter->BandText to Pan) 01/22/18: v2.8.0.65:
Mod FT8 DX Spots move to the correct base FT8 Freq instead of the actual contact Freq. Update dxloc list to add Kosovo Z6 prefix and update SWL files 01/15/18: v2.8.0.64: Fix saving the current Meter type to the database. 01/13/18: v2.8.0.63: Fix combo SWR reading with no RF out 01/11/18 v2.8.0.63: Fix voice keyer buttons (issues that occured
after adding the mode,freq,date,time to the quickaudio file name) 01/09/18 v2.6.0.62: For Flex-5000 with 2nd Receiver only: Add NR,ANF,NB, and DSP Windowing can now be applied to RX2 (checkbox allows you to turn ON/OFF apply) 01/06/18 v2.6.0.61: Add Screen Snap Shot feature. Click on the Camera Icon (just next to the ID Timer) to save a
JPEG image of the Display Area (Panadapter and Waterfall area). Right Click on Camera to open up Folder "QuickScreen" containing the JPEG images. Setup->General->User Interface->Full Console allows you save the Full PowerSDR console image. Image names contain Mode, Freq, date, and time If you want to email a screen shot, just right click

on the Camera icon, start to COMPOSE your email and just drag and drop the jpeg image from the QuickScreen folder directly into your email. You can do the same with QuickAudioMP3 files, just click on the Wave button->MP3 folder, then drag and drop the mp3 file into your email. v2.8.0.60: Add Right click on Map button for external map. Added
CB channel numbers to SWL2 list 12/17/17 v2.8.0.60: Add: In AM mode, when you drag the RX bandpass from both sides of the center line to one side or the other of the center line, RX automatically switches to SSB mode while TX stays in AM mode 12/12/17 v2.8.0.59: Fix check for corrupt SWR1 plot file. Fix check for missing quickauido file.
12/09/17 v2.8.0.59: Fix NOAA SPWC space weather (Change From ftp to http ) 11/29/17 v2.8.0.58: Fix a bunch of Bar Graph meter issues. 11/26/17 v2.8.0.58: Fix Playing QuickAudio over the air caused Receive audio to become distorted (after finished playing QuickAudio). Fix SWR reading 25.0:1 when you MOX the radio with no output power. Now
will read 0.0:1 to indicate no output. (original PowerSDR v2.7 only read SWR in TUNE mode) 11/26/17 v2.8.0.58: Fix Bar Graph 2nd meter (2nd TX of Bar Graph meter not hooked up) 11/25/17 v2.8.0.58: Add PTT hang timer (setup->general->Hardware Config->PTT Hang Timer). When Enabled, and you release the MIC, rear PTT, or CAT inputs, PTT
delays release for set period of time (mSec) (MOX and VOX are unaffected). Update SWL listing. 11/12/17 v2.8.0.57: Fix RX1 Band buttons not set correctly when RX2 ON and in the SWL bands when RX1 on the Ham bands. Add option for TUN button to trigger TX3 RCA jack (setup->Transmit-> TUN uses TX3 jack) for Flex-5000 only. 11/07/17
v2.8.0.57: Fix 30m bandtext for US region. Fix CWX panel not working after its closed and reopened. Receive only mode (Checkbox) now looks at the PTT input (PTT CLOSED = PowerSDR STOP (NO RX OR TX), PTT OPEN = PowerSDR START in RX only). Words on the right side of the SWL Search screen are now Clickable. 10/30/17 v2.8.0.57: Add
"SWL Search" to main PowerSDR console. Fix 17m SWR scanner LOW Freq. Fix Time Server (remove server that is no longer working) 10/24/17 v2.8.0.56: Update BandText for all Turf regions (add FT8 and JT65 Band Text for all regions, and 2m NoV band text for UK_Plus). BandText window is located just below the VFOA/B Freq display. You no
longer need to Reset your Database to update the BandText. Setup->General->Options->Update BandText. This will update BandText to the latest PowerSDR ke9ns version defaults. Also option to Reset your BandStack back to defaults when you do an "Update BandText". Also, DX Spotter automatically selects DIGU when a Spotter Freq falls under
an FT8 Frequency. 10/11/17 v2.8.0.55: Modify SWR band Scanner to allow up to 5 seperate recorded "Runs" per band per Ant. If you select "Panadapter" Mode, you can view up to 5 Scans at the same time. Panafall mode allows you to view 1 of the 5. 10/09/17 v2.8.0.54: Update F1 key help screen for SWR Scanner, Space Weather, ID Timer, and Map
buttons. Fix Bar Graph meter for VHF S meter level, fix SWL 120m band issue, Added bandtext for FT8/JT65 windows (requires a setup->factory defaults). Update SWL (Short Wave) file from eibispace.de 10/07/17 v2.8.0.54: SWR band Scanner/Plotter/Logger for Flex-5000 & 3000 (see Scanner). Saves SWR band plots by Ant (for Flex-5000) and band.
Add VHF S meter correction factor to Bar Graph meter. 09/30/17 v2.8.0.53: Modify weather popout, fix combo meter crash. Bar graph meter is available (left click on the upper meter to cycle through all meter movements) 09/15/17 v2.8.0.52: Add Local Weather flyout panel (North American only, for now). Click on Space weather panel to toggle
Space Weather, Space Weather + Local Weather, or OFF. Click on Local Weather panel to turn OFF just Local weather. Data from forcast.weather.gov Note: Local weather panel will only appear if the PowerSDR console is opened large enough to fit (i.e. space between the space weather panel and the VAC1 button) and the Lat and Long values are in
North America. 09/07/17 v2.8.0.51: Firmware Update: fix Australia region 20m band issue (NOTE: These firmware updates will not effect radios programmed for MARS) 08/28/17 v2.8.0.50: Modify: When you activate RX2 and SPLIT mode together, the sub vfoa now defaults to the current vfoa frequency, then when you click VFO Sync on/off, the sub
vfoa will again set to the current vfoa frequency. 08/21/17 v2.8.0.49: Update SWL.csv file and fix band text mistake for 31m band (requires a setup->factory defaults to see the new band text) 08/04/17 v2.8.0.49: Fix N1MM+ spectrum display not working when powerSDR console too small (or low res). PowerSDR console still needs to be open with Pan
or Panafall turned ON (the PSDR console cannot be minimized). Setup->General->user Interface->N1MM Fix: FT8 mode in Spotter automatically selects DIGU mode. Update: SWL listings (from eibispace.de) 07/27/17 v2.8.0.48: Add (for the Flex-3000, 5000) Combo Meter to 2nd TX meter (Fwd Power, SWR, ALC, and MIC levels) with Peak-Hold
function and Live MIC 07/25/17 v2.8.0.47: Fix D-FM mode. Remove HPF and open up LPF 07/21/17 v2.8.0.45: Firmware and software update: to add additional Turf (Australia) and modify IARU Region 2, in order to keep PowerSDR in Regional alignment with SmartSDR 2.0. You will be asked to update your Flex-1500,3000, and 5000 Firmware the
first time you launch PowerSDR 07/18/17 v2.8.0.44: Modify Seperate Alt Tune Step ON checkbox for either PowerMate or FlexControl (setup->general->user interface->Alt tune step PowerMate and FlexControl). update SWL list (eibispace.de). update the DX spot cluster list (remove k1rfi.com) 07/08/17 v2.8.0.43: Add "Memory" screen UTC Start
Time. You can now enter in a Start Time (for changing frequencies and/or recordings on a time schedule), in either Local Time or UTC time. (i.e. Enter in a Local time, and you will see the UTC time below. Or Enter in a UTC time and it will show the equivalent local time above it) 07/07/17 v2.8.0.43: Add another optional VFO Font (Outline version)
setup->Appearance->General->Bold & Outline 06/29/17 v2.8.0.43: Output Panadapter to N1MM+ logger Spectrum window (setup->General->User Interface->N1MM). The only caveat is that the PowerSDR Panadapter or Panafall screen needs to be up and running in order for it to provide data to N1MM+ spectrum screen. 06/25/17 v2.8.0.42:
Enable VAC2 for Flex 1500,3000, and 5000 without RX2 option. VAC2 on Flex-3000 and Flex-5000 allows the AF slider to change volume level. 06/23/17 v2.8.0.41: Add Time-Out Timer (setup->General->Hardware Config->Time-Out Timer). Cuts off Transmit if you exceed the Time-Out setpoint. Requires you to clear Pop-up Screen before allowing TX
again. 06/16/17 v2.8.0.40: Add Phase invert function (setup->Transmit->Phase invert) for your mic audio. To see the difference set the Display mode to Panascope, and toggle the Phase Invert while you transmit 06/14/17 v2.8.0.40: Add: FM Data mode (experimenting). Toggle between FM and D-FM with Left Click of FM button. D-FM has a wider
Deviation, removal of HPF, and lower pre-emphasis and de-emphasis. Setup->Transmit->FM Wide MIC checkbox (Uncheck to bypass MIC settings) First work directly modifying DttSP. Also add the TX Profile to the CW panel 06/06/17 v2.8.0.39: Add: H3E modulation (experimenting). Transmit Single Side Band AM (full carrier single sideband). Toggle
between SAM (which is really DSB-AM), SAM-L, and SAM-U modes. Also, Click on AM to toggle between DSB-AM, AM-L, and AM-U modes as well. 06/05/17 v2.8.0.38: Fix: Right Click on any DX Spot callsign found in the panadater to open up QRZ page. Right Click on any Memory found in the Panadapter to open up any URL address that was placed
in the Comments for that Memory. Right Click on any SWL Spot found in the Panadapter to open up a Google Search window for that SWL spot. Left Click + CTRL key will move the DX Spot, Memory, or SWL Spot into the Bandpass and setup the filters and mode. 05/30/17 v2.8.0.37: IDTimer: Left Click to start 10 min timer synced to next minute, but
Left Click again to ID on the 10's (every 10 min Interval , synced to the hour) 05/23/17 v2.8.0.36: Fix Russian Turf TX issue. Update SWL (brought to you by: eibispace.de) and SWL2 files 05/19/17 v2.8.0.35: Add setup->display->vfo dials (mechanical dials), (as long as the horz res is > 1400) as an experiment. 05/08/17 v2.8.0.34: Firmware updates to
the Flex-1500, 3000, and 5000 radios for band turf region updates and alignment to SmartSDR turf regions. If you recently Turfed your radio, you may need to reset your database setup-> factory defaults to see updated band text frequency data. 05/03/17 v2.8.0.33: Fix full installer crash because of incorrect PDF file copy over. Now running VS2017
05/01/17 v2.8.0.33: Fix saving and restoring PowerSDR console window in full screen mode (maximize) 04/26/17 v2.8.0.32: Modify ISS Tracking with Beam heading and Elevation (neg values = below horizon) to ISS from your Stations Lat/Long. With circle show approx coverage area. Left Click + CTRL key over ISS to move Antenna to Beam heading.
Thanks to Don Cross for some of the routines I lifted from his web site. 04/23/17 v2.8.0.31: Fix ISS Tracking. Fix Moon tracking. Added Beam heading and Elevation (neg values = below horizon) to Moon (from your stations Lat/Long). Left Click + CTRL key on Moon to move Antenna to Beam heading. Fix Check for Updates link back to this web page.
04/22/17 v2.8.0.30: Add ISS Tracking (Needs Internet connection to get ISS data, Moon and Sun do not need Internet) 04/22/17 v2.8.0.29: Add Moon Tracking (with help from Paul Schlyter, stjarnhimlen.se/comp/tutorial.html) in addition to the Sun 04/18/17 v2.8.0.28: Add button to check for Software updates (to Setup and About screens). Fix: Turf
Regions (realignment) 04/16/17 v2.8.0.27: Add: Flex-5000 & 3000 2nd TX Meter MIC mode is now Live during receive (make sure your not using the "Default" transmit profile), so you can check your MIC level before you transmit. Modify: SDRQuickaudio file name now adds Mode, Freq, Date, and Time to end of file name for .wav and .mp3 files but
does not interfere with quick recordings or special quickaudio buttons . Update SWL.csv file (Donate to eibispace.de if you like the SWL listing) If you updated to Windows 10 Creators Update Build 1703, there is now a Gamers Mode (Win + G keys). Click somewhere on a running PowerSDR console to put it in Focus, and hit Windows + G keys to
activate. Click on the Settings wheel of the Gamer mode pop-up window and turn off the "Show Gamer mode" option and also click ON "User gamer mode for this game". Gamer mode is supposed to give higher CPU priority, but lets see if it helps PowerSDR??? 04/11/17 v2.8.0.26: improve signal Ident 04/10/17 v2.8.0.25: SWL Spots now appear in RX2
as well as RX1 04/09/17 v2.8.0.24: Signal detection: Scanner->Sig Ident->ON. Just experimenting. Fix RX/TX text at the top of each meter. 04/03/17 v2.8.0.23: Update 2nd meter 03/31/17 v2.8.0.22: Update: selectable NIST time server list (top line of Spotter window), used when doing an Internet time sync from the spotter window. Force WWV Time
sync to use 4096 RX buffer to properly detect wwv time ticks. 03/25/17 v2.8.0.21: Update to DXLOC.txt country list 03/24/17 v2.8.0.21: Fix mistake in low-high freq scanner step and speed. Fix SWL list mistake and update SWL listings from eibispace.de 03/23/17 v2.8.0.21: Fixed 2nd meter not appearing at startup. Mod: "Scanner": can now stop the
"Memory" scan and click on a memory shown in the list and go directly to that frequency. Fix: TX WaterID: add space between letters of your callsign to make it more readable. 03/20/17 v2.8.0.20: Modify Click on 2nd TX meter to toggle it up just below the 1st RX meter or normal bottom position. You can also go to setup->Transmit->Move 2nd Meter
to change position of the meter. This makes it easier to see your ALC and power out at the same time. And new Sliders when using the ke9ns skins 03/19/17 v2.8.0.19: Modify: New sliders when using the ke9ns skins. Add Group name to scanner output screen. Fix: Time Sync via internet (when it gets delayed connected to NIST) 03/14/17 v2.8.0.18:
Add: Update to Scanner button: MEMORY "GROUP" name scanner and BandStack memory scanner. Scan your Frequencies from your Memory list by GROUP name, OR Scan your current BandStack, OR now by a custom list in a text file. 03/5/17 v2.8.0.17: Fix: updated the DXLOC list (missing a few countries callsigns) and updated SWL list from
eibispace.de Fix: Left click + CTRL on DX callsign in Panadapter, sets the Radio to that DX station Frequency, mode, split, just like clicking on a memory found on the Panadapter, and highlights that station in the DX Cluster spotter window to make it easy to find them (the Right side callsign + CTRL also sends Rotor command as well). See for a list
of clusters. CTRL + Right Click on DX callsign in Panadapter OR Right click on DX line in the Spotter window still opens up QRZ page for that DX station. ADD Flex-5000: Display the current SWR, CAP, IND settings of the ATU. When the ATU is ON (hit the ATU button on the main console screen to engage the ATU), and you hit the "TUN check"
button on the ATU screen, it puts the radio in TUN (at the powerlevel stated by the TUNE: slider), and it takes a new reading (FREQ, FWD,REF,SWR,CAP,IND) then unkeys the radio. Arrow buttons < > allow you to manually override and INC or DEC the CAP and IND values from 0 to 127. Note: This SWR is the AT-200 ATU tuners SWR meter and not
the Flex SWR meter. If you change the CAP or IND values and go outside the set SWR threshold, you will need to reset the auto tune before you can change the CAP or IND values again. 02/25/17 v2.8.0.17: Add Post DX spot contact via the Spotter "Callout" button (i.e. Post your contact to the Dx cluster directly from PowerSDR) Two ways to Post a
contact: 1) Make a contact, type in the contacts Callsign in the "DX Callsign" box and hit Post, then confirm YES to the pop-up message box. 2) Select a DX spot from the DX Spotters list, make contact, then hit Post (leave the DX Callsign box alone), it will use the highlighted DX contact as the callsign. Within a few seconds (or 10's of seconds during a
contest), you will see your post appear at the top of the DX Spotters window. The "Remarks" section will state the mode (LSB, USB, CWL, DIGL, etc.) and split (qsx freq if any). Note: The DX Cluster must be active and running in order to Post to the Cluster. Also, your posting under your Callsign as the Spotter. 02/17/17 v2.8.0.16: Fix Ant Rotor
function (sending commands to Rotor Port on DDUtil). Fix TxWaterID text mistake. 02/14/17 v2.8.0.15: Fix vhf/uhf selection in decimal comma Regions. Improve TX WaterID text and 24bit BMP image display 02/12/17 v2.8.0.14: Improvments to Waterfall Image feature: Add setup->transmit->Wider TX WaterID option. When enabled, the TX Waterfall
Callsign ID (waterfall image) will transmit at the current TX Width (instead of the original 2.4khz). You may need to move your mouse over the callsign box to update your callisign image to your current transmit bandwidth. (Example: 4khz wide TX audio will transmit your Callsign ID into the waterfall 4khz wide. 01/26/17 v2.8.0.12: Fix Time button.
Update NIST time server list 01/26/17 v2.8.0.11: Fix DJConsole A>B, Aappearance->meters->Light Meter background or Dark Meter background), overrides the Low Color when either is selected. 01/19/17 v2.8.0.7: Fix 60m Region 1 bandtext, Add band edge markers to 60m lowest and highest points(even though there are channel markers within
the 60m for every Region and Turf) , and correct transition frequencies between 60m ham band, and SWL bands 61m, 49m. 01/16/17 v2.8.0.5: Fix new AF/MON slider selection and Drive/Tune slider selection 01/12/17 v2.8.0.4: AF and MON Volume Level Sliders: Left Click on either AF: or MON: text to change the Slider to allow changing the value of
either the Main Volume control or Monitor Volume control DRIVE and TUNE Power Level Sliders (with Lock feature): Left Click on either Drive: or Tune: text to change the Slider to allow changing the value of either the Main Drive control or Tune Drive control Right Click on Drive: or Tune: text to toggle between Lock and UnLock. Be sure to preset
the drive levels for each band before locking. It will not prevent the levels from changing when you change bands. Moved RX1 mute checkbox down next to RX2 mute 01/12/17 v2.8.0.2: Temp color match Flex colors 01/11/17: v2.8.0: Change name from current T12 to v2.8.0. Create a Full Stand Alone PowerDSR ke9ns v2.8.0. Self contained Installer
file contains NET 4.5.2 and VC Runtime distribution files as well as all drivers, firmware and software needed, without the need for a prior 2.7.2 install. Modified PowerSDR ke9ns v2.8.0 to create new 2.8.0 database & quickaudio folders, but copy over the contents of the 2.7.2 database and quickaudio folders, so if you have a prior installation, you
wont lose anything. Fixed: CWX panel issue closing with poll cw key checked. 01/08/17 T12: Add: Setup->Display->Spectrum Grid->Align->"S-Unit" mode (the Pandapter horizontal grid forms based on the S-Unit scale). Fix: MUTs left ON at power down,not highlighted when powered back on. Fix: Band UP/DOWN feature to add the SWL bands.
Update SWL file from eibispace.de 01/06/17 T12: Add: Reply button to answer a call from a DX station with your callsign (voice or cw) Add: CQCQ button to make a CQ call (like for example: during a contest). CQ CQ DX DE Use Wave->Reply and Wave->CQCQ to start/end both audio recordings Add: Northwest Research Associates Space weather
services Effective SunSpot number "ef" to the space weather panel. This number is determined from ionospheric mid-latitude foF2 observations, as opposed to the SunSpot number "ss" which is optical. Add: Turf designation to the end of the serial# on the top line of main console window. 01/05/17 T12: Add: 5 sec Popup timeout to ID Timer Popup
window (checkbox on popup window). Add "Call CQ" button. Use the Wave->CQCQ button to record a CQ recording. 01/04/17 T12: Firmware update for the Flex-1500,3000, and 5000 models to add the "IARU Region 1" 60m band to Europe. Band Text for the new 60m segment has also been added. NOTE: This firmware will not disrupt any prior
TURFed settings like MARS or UK. NOTE: This firmware will not prevent you from running the basic original Flex 2.7.2 PowerSDR First time your run T12, PowerSDR will ask you to allow the firmware upgrade. Say Yes. If you are in IARU Region 1 with the new 60m addition, you will need to do a setup->factory defaults to reset the database in order
to see the band limits. The First time you run T12 Windows may popup a Firewall block access message, make sure to allow access, otherwise you will not be able to DX spot, or get solar weather. Add: In "Wave" menu: add 3 Buttons to help record Voice to IDTIMER.wav, CW to IDTIMERCW.wav, or CQ call to CQCQ.wav So you will not need to
manually rename files to use with the ID timer. Voice ID: Click the button, record your voice id, Click to save IDTIMER.wav file automatically overiding any previous IDTIMER.wav file. CW ID: Change over to CW mode, Click the CWX panel, type your call sign into one of the macro boxes, Click the Wave CW ID button, Click the the macro box with
your callsign, when done Click to save IDTIMERCW.wav file. 01/02/17 T11: Fixed GrayLine (again). Fixed: Wheel Tune didnt work when the mouse was over the date/time/cpu panel. Now it does. 01/02/17 T11: Revised Operation of the ID Timer: Station ID Timer (10min): LEFT Click on the “ID Timer: OFF” (just above the PowerSDR clock). This will
start the 10 min countdown timer (synced to the nearest minute, so the first go around may be less than 10 min). When the counter reaches 0, “TIME TO ID” will flash. Right Click on the “ID Timer: xx” toggles between: Voice timer “voID Timer: xx“: Transmits an audio file with your voice called IDTIMER.wav CW timer “cwID Timer: xx”: Transmits an
audio file with CW recorded, called IDTIMERCW.wav Waterfall ID Timer “wfID Timer: xx”: Transmits your Callsign, that you type in the TXwaterID box found on the top line of the PowerSDR console. Make sure this box is Green. So at the end of the count down, in addition to the “TIME TO ID”, it will transmit 1 of 3 files. TO Record your IDTIMER.wav
or IDTIMERCW.wav file: You must have wave->Quickaudio save folder enabled, then Check the “Rec/Play ID” box, hit the REC button and record your ID message, hit the REC button a 2nd time to end your message. Right Click on the PLAY button and right click on the newest file created and rename to IDTIMER.wav. After you rename the file, select
IDTIMER.wav and click OPEN. You now have a permanent ID message. NOTE: this will work for recording a CW message. If you put the Flex into CW mode, hit the REC button and tap out your callsign (or use the CWX panel), then hit the REC button again when its done sending your call, then put the Flex back into SSB. Rename this file
IDTIMERCW.wav. 12/30/16 T11: Fix RX2 panafall mode display. Fix MON: slider not remembering volume level when using PLAY button. 12/29/16 T11: Fix: AF: Slider not going into MON: slider when using the PLAY button 12/28/16 T11: Add: ID Timer Audio output option: YouTube Video Describing RevT11 (ID TIMER): 12/27/16 T11: Fix: ID Timer
Popup Window can be moved anywhere and will remember position permanently. Add: Mouse wheel Click on TUN button will open Setup->Transmit window. 12/26/16 T11: Fix Adjust VFOA/B locations to allow for smaller console size. Add FlexControl text to Setup->General->User Interface, for Alternate Tune Step Rate. 12/23/16 T11: Fix: No CAT
when Display was turned OFF. Fix: voacap map stop updating when spotter form closed. 12/22/16 T11: Add: FlexControl can now use the seperate Tune Step (setup->general->user interface->Powermate->Independent check box). This way the Main console TuneStep can be used for the Mouse Wheel, and the other TuneStep for the Flexcontrol (or
PowerMate knob) Add: Map menu button (top bar in PowerSDR), to toggle the Tracking map on/off directly Add: S Signal scale appears on Right side of Panadapter (when the dBm are set to appear on the Left or Auto). Remember if you set the "AVGp" button for the Panadapter, the S readings on the Panadapter will not be the same as the Meter
(unless you select Avg for the Meter as well) . Add: IARU Region 1 for the WRC-15 allocation (5351.5 - 5366.5 kHz). You would need to create a new database file. This does not open the Flex radio itself, just PowerSDR. Its up to Flex to provide the Turf File for the IARU Region 1 radios. 12/21/16 T11: Add: Pop up box for "Time To ID" that goes away
after 5 seconds (or clicking OK). Right Click on ID Timer to add TXWaterID transmit when its time to ID. 12/18/16 T11: Add: 10min Station "ID timer" (in the date and time panel). Click to Start timer. Flashes the ring color when its time to ID and repeats every 10 min. YouTube Video Describing RevT11 (BandStack,Pulser): 12/15/16 T11: Add:
Optional Bold/Oblique Swis721 font for the VFOA/B (setup->Appearance->General->VFO->Bold Font VFO 12/14/16 T11: Add: Right Click on BandStack indicators (next to TuneStep) and BandStack flyout panel directly into right side of Pandapter area. Left Click opens up a seperate Bandstack window (as was done previously) 12/12/16 T11: Fix:
BandStack: ADD,SORT,DEL buttons. Can add up to 12 freq / band 12/10/16 T11: Add: Grabs NWRA.com Effective SSN (SSNe) for use in voacap progagation mapping. Also attempts to compensate for large K index values by reducing contour signal strength. Also, Larger VFO Freq display. 12/10/16 T11: Add more visual updates to main console
screen. 12/06/16 T11: Fix: DX Spotter window now highlights the last selected DX spot (from either the click in the spotter window or red dot) 12/05/16 T11: Fix: prevent ATU start while in Pulser Tune mode (atu can be on, just dont want it to try to find a match while in Pulser mode). Transmit on VFOA or B causes ring around VFO to change to RED.
12/03/16 T11: Add: VOACAP optional Contour plot lines (using C/Fortran code by Paul Bourke). Add: Can now choose the accent color around the VFOA/B and Meters. 12/01/16 T11: Add: BandStack window, Delete entries using Mouse Wheel Click, Sort list with Sort button (low to high freq) 11/30/16 T11: Improve Pulser function (more accurate and
stable). Improved visual changes to VFOA/B and Meters. 11/28/16 T11: Work on VFOA/B panels. Update SWL file from www.eibispace.de. Move VOACAP map in front of Grayline map. 11/27/16 T11: Fix: Mouse digit select, on VFOA & B (because I had enlarged the VFO numbers previously) 11/25/16 T11: Add: TUN button: Right Click to toggle TUNE
button between TUN = Standard continuous wave TONE, and TUNs = Pulser TUNE mode. Go to Setup->Transmit and select pulses/second and duty cycle of pulser. Not as precise as using the cwx, but doesnt require a mode change. DRIVE Level Lock: Right Click on DRIVE: text (just above the drive power level slider) to LOCK = RED or UNLOCK =
WHITE Drive level (as well as the TUNE drive level). Be sure to preset the drive levels for each band before locking. It will not prevent the levels from changing when you change bands. 11/23/16 T11: Add: HttpServer Advanced Mode allows Frequency, Band, Mode, Filter remote selection as well as Pan display, brought to you by Nick RN3KK (note:
this is currently not password protected) 11/22/16 T11: Fix: VOACAP map. was using wrong S unit scale (dBM, but voacap is dBW). Also map changes with Mode: CW vs SSB vs AM, because CW requires less signal strength for a contact. 11/18/16 T11: Fix: Voacap crashing below 1mhz and also not updating immediatly with direct freq entry or swl list
selection Fix: When in MUTs AF slider not adjusting volume for your Headphones. 11/16/16 T11: Add: Watts slider for VOACAP (adjustable from 1watt to 1500watts) 11/15/16 T11: Fix WWV time decoder not reset filter back to original size when decode ends. 11/15/16 T11: MUT button: Right mouse click on MUT button to toggle between Muting all
sources or Muting just the speaker (not the headphones, and not VAC1). “MUT” = standard mute, “MUTs” = mute speaker only. 11/15/16 T11 Fix: fix VOACAP not reading frequency correctly for certain "regions". Fix: Voacap using SFI based SSNf, with TX power reductions based on value of K index. Add: Beam ant option to voacap vs dipole
YouTube Video Describing RevT11 (VOACAP): 11/14/16 T11 Add: VOACAP Propagation prediction from your transmitter location: Using Date, Time, SunSpot#, Frequency, and selecting your Lat & Long location using a Dipole @ 1500 watts, a SdB propagation map is created and presented onto the “Track”ing World Map. Dots represent the Signal
strength of a person at that location (around the Dot) trying to Receive your Transmission. Small Gray Dot=S1-S2. Small Orange Dot=S3-S4, Med Yellow Dot=S5-S6, Large Green Dot = S7-S8, Large Gray Dot = S9-S9+. The SunSpot# will only work when you activate the PowerSDR console Space Weather (lower Left side of screen). Might try
converting Dots to Contour lines?. I install a seperate copy of Greg Hand's compiled version of NTIA's / ITS Voacap Fortran program. Works up to 30mhz. Added a Red Star to indicate your Stations Location on the world map, based on your given Lat and Long values. 11/11/16 T11: Fix: Grayline issue. Update SWL file (from eibispace.de) 11/08/16
T11: Fix: WWV Radio Time/Date Decoding now working for Flex-1500 as well as 3000, and 5000 11/07/16 T11: Add: Griffin PowerMate USB Knob: Now can have its own adjustable tune step rate (apart from the MouseWheel and keyboard). setup->General->User Interface->Independent. Updates to SWL and SWL2 files 11/06/16 T11: Fix: Added "Day
of year" to WWV decoder reception. This is required to get the Date correct when the time is updated to your PC. Fixed "Beacon chk" and "Time Sync" not allowing dx spotting to reappear back in the spotter windows when you turn the "Beacon chk" back off, or as soon as "Time Sync" is done. 11/05/16 T11: Fix Time Sync Internet NIST locking up on
a failed connection. 11/02/16 T11: Added simple Goertzel Tone detection to WWV time decoder (provides better S/N ratio). Only issue is 100 hz required sample time needs to be a little longer than a 2048 192k SR, so automatically set SR to 96k during WWV time decoding. Frequency, Filter, SR, Buffer parameters are saved during the decode and
restored after the decode is done. NOTE: PowerSDR must be running in ADMIN mode to allow PC time to update. Youtube Video describing the Time Sync Function: To update your PC time using Radio WWV time: Check "Use WWV HF" box and click "Time Sync" button and watch the Spotter window for the decoding process. This can take up to 1.5
minutes, if you just missed the start of the last minute. Watch the "Tone" indicator to make sure it is following what you are hearing as far as the Ticking sound of WWV. If the Tone indicator is not following, then the Signal strength of the sub-carrier is too weak, signals are fading, or a storm is disrupting. To update your PC time using Internet NIST:
just click on the "Time Sync" button (without the "Use WWV HF" checkbox). Decoding process takes milliseconds. Fixed: Upated to latest SWL.csv file and Fixed another SWL display and listing issue. Fixed: Full duplex with TX on VFOB keeps the AF slider as AF (except if you have the MON enabled, then the slider changes to the MON AF setting as
it should). And now RX1 Mute checkbox works in full duplex with VFOB set to TX. 10/30/16: T11: Started work on my very first decoder. WWV BCD time coded sub-carrier. This current version uses signal strength and simple filters,so it doesnt work well (needs to very strong and clean WWV). 10/25/16 T11: Fix mistakes in the SWL "day & Time"
checking. Fix mistakes in the Beacon scanner. 10/22/16: T11: Add: NIST Time Sync Button to Spotter window. NOTE: You must Launch PowerSDR in ADMIN mode in order to allow the "Time Sync" button to update your PC time. To Permanently set ADMIN mode, right click on the T11 Icon then: Properties->Compatibility->"Run this program as an
administrator". You must also have Internet to connect to NIST. This is useful for the Beacon Scanner, WSJT & WSPR and any program requiring your PC to have accurate time. Fix: Save the last Beacon Signal readings, Until you start a new 3min or 15min scan. Youtube Video describing the Beacon Scanner: 10/20/16 T11: Fix: Can now leave DX
spotter running while checking Beacons (it just hides the dx spots, until you switch beacon off) 10/19/16 T11: Improve Fast Beacon Scanner (1.25second per beacon) and map display 10/18/16 T11: Fix Grayline (when entire top artic area stays in dark) 10/16/16 T11: Add Experiment:NCDXF Beacon Scanner: This feature gives you a direct method of
determining radio wave propagation conditions(i.e. band conditions) for the 20m,17m, 15m,12m, and 10m bands. A System of 18 stations, around the world, transmitting (24hrs / day) in 10 second intervals on 5 frequencies (5 separate stations simultaneously) on 14.1mhz, 18.11mhz, 21.15mhz, 24.93mhz, and 28.2mhz. (Repeating every 3
minutes).Your PC clock must be accurately set to make sure PowerSDR matches up with the Beacon stations.Under the “Spotter” window is a “Beacon Chk” button with Fast & Slow Scan options. You will see a list of Beacon stations (upper left corner) and the current 5 stations transmitting). With “Map Calls” checked, you will see all 18 stations (and
each of their 5 frequencies). Slow Scan: Starts on 14.1mhz beacon and listens for 3minutes (1 complete loop) for 18 stations and records their signal strength, then moves to 18.11mhz, and so on, until 28.2mhz. 15 minutes total time. You can select the starting band 1 through 5. 1=14.1mhz up to 5=28.2mhz Fast Scan: Scans through all 5 Beacon
frequencies (1 second per beacon) in a single 10 second interval, and records the signal strength on each frequency. It repeats this quick 5 frequency scan 18 times to get a complete Beacon map in 3 minutes, but is not as accurate as the Slow Scan. You might notice a startup lag (of up to 10 seconds) because PowerSDR needs to be in perfect sync
with the Beacon stations. Colors On the World Map: Gray = Not scanned yet. Violet = Currently Scanning, Red = Not detected, Yellow=Not detected/Weak, Orange=Light, Green=Strong. On the SPOTTER window: All 18 stations x 5 frequencies are listed (total of 90 entries) As the stations and frequencies are scanned, signal data is added to the
SPOTTER entries. -NA dBm = Not Scanned yet. S9 -018dBm = S9 signal level, but only -18 dBm above the noise level. At the Start of any Scan, the Mode is changed to CWU with filters set to 550hz - 650hz. This is to try and eliminate extraneous noise. Prior operating Mode and Filter High/Low settings are restored when the scan is finished. See for
further details 10/12/16 T10: Fixed SWL/SWL2 merge mistake. Updated SWL.csv file and SWL2.csv files adding HFDL, ALE, DSC, Maritime channels, and NXDXF Beacons to the list. 10/11/16 T10: Add: Automatic Antenna Control: Setup->CAT Control->Enable Rotor. You must select 1 side of a virtual COM port pair. The other side of the COM pair
connects to DDUtil. DDUtil will automatically convert the beam heading into the proper format for your Rotor control. Left Click on the BEAM HEADING of a DX spot in the Spotter window to Move Antenna OR, Left Click on the Right Side of a DX Spot + CTRL Key in the Panadapter to Move Antenna In DDUtil open setup form->AntRtr and setup your
antenna Rotor control(s). Then go to setup form->Ports->RCP1->Rotor Port and the “Other side” of the COM pair from PowerSDR. YouTube Video Describing RevT10 (Rotor Control): 10/08/16 T10: Fix: SWL daysofweek mistake 10/07/16 T10: Add: Http Server now streams live Display with no special commands or special setup. Setup->User
Interface->Active. Open your web browser to to stream Display. Refresh rate sets the update time in msec. Still experimenting. Thanks to help from Nicholas RN3KK 10/06/16 T10: More fixes to SWL Spotter to reduce clutter. 10/05/16 T10: Fix: SWL Spotter now looks at DayofWeek to remove duplicate spot on panadapter display. 10/03/16 T10: Fix:
Mininum size for windows (like the Memory or Spotter windows) no longer 0, so they wont disappear on you. Fix: HttpServer no longer requires anything special (other than a "Port Forward" in your router only if you want outside access). Thanks to help from Nicholas RN3KK (user name and password not active at the moment). If the Httpserer
checkbox is active, use: 10/02/16 T10: Add: if Wave->"QuickAudio Save Folder" box is checked,MP3 Quickaudio files now goes into QuickAudioMP3 folder instead of the QuickAudio folder (which contains just WAV files). Fix: MP3 option (both Schedule and QuickAudio) set Wave to POST 48kSR during recording, and set back to original settings when
done with recording. Fix: Flex Temp & Volts now in its own thread. 10/01/16 T10: Add: MP3 option (Wave->QuickAudio CreateMP3 checkbox) to save an MP3 of each QuickAudio file (makes it easy to message or email your friends a copy of their audio recording) 09/29/16 T10: Fix Allow FlexControl to run VFOA slider. 09/28/16 T10: Experimenting
Add: HttpServer. Setup->General->User Interface->HttpServer. Setup Port# and UserName and Password. Example: If you use Port 8081 and want to remotely access, you must "port forward" port 8081 to your PC running PowerSDR. Now you can use a web browser to view the PowerSDR Display window. Hit F5 to refresh for now. 09/27/16 T10:
Fix: SWL listing screen, now that the list is larger. Fix: forgot to include dll's in installer for the mp3 creation. Fix scheduler mistake (losing data) 09/26/16 T10: Add: SWL2.csv short wave listing file. This gives the ability to add SWL or Utility frequecies not in the SWL.csv file provided by eibispace.de. For this first round I have added HFDL digital
frequecies. Download the free PC-HFDL to decode the data streams. PowerSDR stitches the SWL.csv and SWL2.csv file together when you activate the SWL spotter. Email me and let me know of any SWL or HF Utility frequencies not found in the current list, and I can add them. Between the SWL.csv and the new SWL2.csv files PowerSDR T10 will
have a more complete list of signals outside the Ham bands (even if many signals cannot be decoded unless your part of the government). YouTube Video Describing RevT10 (Beam Heading): 09/25/16 T10: Add: Beam Heading added to both Spotter window and Tracking Screen. Put in your Lat/Long into the boxes next to your callsign on the Spotter
screen. Checkbox to have them show up on the Map or just the Spotter window. When Tracker is enabled: Left Click on Display somewhere and hit SHIFT key to see the Lat/Long grid map to help you determine your Lat/Long. Enlarge VFOA/B even more 09/23/16 T10: Add: MP3 output of scheduler/recorder files. Much more compact file size. Easier
to email or IM to someone. Still uses WAV for all other recordings (the standard WAVE and QuickAudio files) 09/20/16 T10: Add: My first attempt at a Sliding VFOA (i.e. the VFOA slides around a stationary display, instead of the normal display sliding under the VFOA bandpass ). Left Click the "PAN:" text button to activate (turns Red). Works, but
needs more work. I am trying not to break anything while adding this feature. 09/14/16 T10: Fix: reduce Scheduler Recording SR down to 48k automatically to reduce .wav file size. Fix issues with clicking on memory column headers or starting with an empty memory file. Fix: If PowerSDR was Stopped when recording started, PowerSDR will Stop
again after the recording is done. Now at 48k SR, it will be around 600mb/30minutes of recording. Persistance in clicking temp/volts, space weather, dx spotter NA or exclude NA. Working on adding an MP3 output to save more space. YouTube Video Describing RevT10 (Scheduler): 09/12/16 T10: Add: Memory Event Scheduler / Recorder (modifies
your memory.xml file by adding Memory/Frequency Scheduling, but makes a mem.bak backup first). Will change frequency and mode (based on Memory) either Weekly, or once a Month, and optionally Record Audio, for a specific Duration (in minutes) 09/09/16 T9: Slight enlargement of the VFOA and VFOB frequency displays 09/08/16 T9: Slight
width enlargement of the Analog Meters 09/07/16 T9: Add: Auto Panadapter Scaler: Left Click on the "Zoom" slider text to toggle between Small signal (RED) and Standard signal Scales (WHITE). Small signal scale is based on the maximum strength signal present when you click on "Zoom" 09/06/16 T9: Fix Installer. Abandoned the microsoft installer
for the very nice "Advanced Installer", BUT you will need to do an windows Control Panel UNINSTALL of any PowerSDR RevT9 if you previously installed T9 with the older Microsoft Installer I was using before. 09/04/16 T9: Fix 6m lower band edge for UK (was 50.08, now 50.00) 09/02/16 T9: Add: Lat/Long indicators on Sun Tracker World map. Tap
Shift button (with the Main PowerSDR window in Focus) to toggle Lat/Long on/off (along with toggling between DX and Spotters call signs on the panadapter). includeds E,W,N,S as well as - / + indicators 09/01/16 T9: Fix: Space Storm indicator on sun tracker when Console space weather is not active 08/31/16 T9: Fix: Allow VAC1 to stay active if in
Full Duplex mode and TX on VFOB and "Auto Mute RX1 on VFO B TX" unchecked. 08/28/16 T9: Fix: Add code from W0DHB to prevent changing TX filters, in FM mode, when VFOB TX is selected 08/26/16 T9: Fix: DDS increment size reduced 08/24/16 T9: Fix: When you minimize a window, you can now bring it back up from the same button that
opened it in the first place, instead of findinig in the windows Tray to open it up again. 08/21/16 T9: Add: SWL list screen showing currently operating stations by frequecy and is searchable by name (example: type fax, shows all currenly operating fax frequencies). You must first go to the Spotter screen and turn on the SWL spotter: "Spot SWL" and
then "SWL list" YouTube Video Describing RevT9 (SWL Search): 08/17/16 T8: Fix: Bandstack memory LOCK feature (wasnt working) YouTube Video Describing RevT8 (BandStack): 08/16/16 T8: Add: Bandstack memory LOCK feature (RIght Click on Bandstack Memory to toggle LOCK/UNLOCK) Fix: Highlighting the current Bandstack memory.
Update DXLOC.txt and SWL.csv files 08/04/16 T8: Fix: "Auto Wter/Pan Lvl" not working correctly when in straight Panadapter mode. 08/03/16 T8: Add: "Auto Wtr/Pan Lvl" button changes to BLUE with a LEFT CLICK and RED with a RIGHT CLICK 08/01/16 T8: Add 25mhz WWV to bandstack (CTRL + Right Click on the WWV button to add). Fix:
Prevent a PSDR crash when quickly clicking between CW message queue's. 07/20/16 T8: Clean up the bandstack routine, remove the powermate trace, clean up the space weather routine. 07/20/16 T8: Fix: space storm indicator. Change Wave audio to "Post" when the Rec/Play ID checked. 07/18/16 T8: Add: Estimated International Sunspot Number
to main console window (updated at top of every hour) YouTube Video Describing RevT8 (Space Wthr): 07/17/16 T8: Fix PowerSDR not closing properly 07/14/16 T8: Fix: CW Speed WPM syncs between the console window and CWX. Add: CW Key Poll feature. When Checked, allows your CW Key to interrupt a CWX transmission (both memory and
keyboard), not just the ESC key. Add: K-Index to space weather on the main console window. 07/13/16 T8: Fix: space weather not updating on the hour.(cross your fingers) 07/12/16 T8: Fix 10m bandstack causing crash. Fix: geo storm ind. 07/11/16 T8: Add: NOAA Space weather added to main PowerSDR console (just below date/time). Updates once
per hour. 07/10/16 T8: Fix: RX1 mute feature (deactivate when RX2 turned back off). Fix Geo storm indicator. 07/08/16 T8: Add: Geomagnetic storms level to sun tracker SFI and A index readings. Already had Radio Blackout levels. 07/05/16 T8: Add: BandStack Panel. Left click on either Band Stack indicator (just to the right of the big "Restore"
button at the top center of the PowerSDR). When the Panel is open, you can Left Click on any Frequency in the Band Stack and go directly to that Frequency. 07/02/16 T8: Add: RX1 Mute checkbox appears only when RX2 enabled. This allows RX1 to be Muted, still hear RX2, but still send RX1 VAC to your PC. Update to the current latest SWL.csv file
07/01/16 T8: Fix: had accidently had TXwaterID level output set too high 06/26/16 T8: Requires vcruntime140.dll for 64bit machines. this version installs it. If that doesnt do it, download the Microsoft installer: 06/24/16 T8: Add: PowerMate directly into PowerSDR (instead of using an external program). See Setup->General->User Interface->Active to
activate PowerMate for changing frequency (currently based on the Tune Step). You can adjust the speed. Tap Knob to cycle through Tune steps: 100hz, 250hz,500hz,1khz If RIT is Enabled, the Knob changes the RIT value (Tap to Zero the RIT) Also decided to just include DJConsole instead of compiling a seperate version with and without it. 06/15/16
T7: Add: Allow SWR in all modes instead of just Tune (for the 3000,5000) 06/12/16 T7: Fix MUT button function when using TUN button (caused by me reducing the TUN volume when in MONitor mode) 06/09/16 T7: remove space beteween meter and digital value. Update SWL.csv 06/08/16 T7: remove lines around meters and frequency. Lets see
what happens. 06/05/16 T7: Fix: Allow RX2 meter on low res 1366 x 768 displays, but you must also activate "Auto-Hide the taskbar" to get maximum available vertical pixels available. Right click on the task bar ->properties->Auto-hide the taskbar. YouTube Video Describing RevT7 : 06/04/16 T7: Fix: RX2 RX meter when TX 2nd Meter Active is
checked. 06/02/16 T7: Add: Use the RX2 meter for optional 2nd TX meter (i.e. TX meter = ALC, and TX 2nd meter = Fwd Pwr). Go to Setup->Transmit->"TX 2nd Meter Active" checkbox to activate feature. TX2 has all the same meters as TX1. Works with the Flex1500,3000,5000 Bypassed if you have a RX2 installed and the Auto Bypass RX2 is turned
off. 05/19/16 T6: Fix: Panadapter Memories text wont overlap DX or SWL spot text. Fix: Extended Expert antenna function not selecting SWL ant. 05/18/16 T6: Add: MultiRX auto reset checkbox in setup->Display. When checked, Zero's MultiRX when button pressed to turn ON. 05/12/16 T6: Update SWL.csv file. Add ke9ns skins 05/11/16 T6: Add:
Display "Memories" to Panadapter option in Spotter window. If you see a Memory displayed in the Pan, Left Click Mouse on Memory + CTRL key to change all parameters to that Memory. OR find a new Signal you want to save as a Memory: then ALT & M keys to save a new "Memory" and the Pan will automatically reflect the update. Fix: shut down
waterfall when radio off and in Track mode. Allow up to 15k wide RX only (experimenting) YouTube Video Describing RevT6 : 05/02/16 T5: Add: Slider offsets for the Auto Water and Auto Pan. Under Setup->Display. Moved Hero's Menu item, over to the right a few spots to help allow Spotter Menu button room on small Displays. Update to SWL.csv
file. Update to DXLOC.txt file 04/30/16 T5: Fix: Exclude NA Spotters. Fix: Panfill alpha. Update DXLOC.txt file 04/29/16 T4: Fix: Color selection for Analog Meter and Edge meters. 04/27/16 T4: Fix: prevent crash if NOAA ftp site cant be opened. Fix: MON turns on when in CW mode (if Sidetone is on), but wasnt turning back off in when changing back
to other modes if you originally had it off. 04/26/16 T4: Add/Fix: cursor position freq offset, pan (dbm), cursor position waterfall history (seconds), Freq, now correct for rx1 and rx2 Fix: increase font size of dx cluster information. Fix DXLOC.txt 04/24/16 T3: Fix: missing callsign warning in DX spotter Add: Panadapter color select and transparency of
Pan Fill 04/23/16 T3: Fix: DX spot "age" routine, which wipes your dx spot list. (base 60 issue) 04/22/16 T2: Fix: MultiRX now starts syned up to VFOA ( syncs either VFOB or VFOASUB (if RX2 enabled)) so the blue window now always starts on top of the main VFOA. This is a successful Spot DX launch 04/20/16 T1: Add: save multiple DX cluster:port
data Fix: waterfallgrid freq #s cutoff when in special panafall mode with a shortened screen. 04/1816 S12: Add NOAA Radio Blackout indicator to Sun tracker. Add inverted Analog meter. 04/17/16 S12: Fix: PowerSDR AppDataPath mistake 04/15/16 S12: Fix: crash caused by bad callsign or URL or port. Add Self-Extracting zip file for automatic install
of PowerSDR Rev S12 04/14/16 S11:Fix: an issue that PowerSDR will crash when you hit the spacebar if the DX spotter is on, but nothing is in the dx list yet. Fix: DXLOC.txt, Seperate out Australia into lat/lon areas 04/13/16 S11: Add: Right click on "Auto Wtr/Pan Lvl" button and auto correct the Panadapter Grid min level. Note: Flex did not store a
seperate Grid MIN value for each band (like it did for the waterfall Low level value). Fix: Meters not working when operating on Extended mode freq. Fix: More DXLOC.txt updates 04/11/16 S10: Add: Click on any Red Dot on Map then hit CTRL button to go directly to DX Spot Frequency. Fix: crash if you DX spot without copying over the DXLOC.txt
file into the database folder. Update DXLOC.txt file spots 04/09/16:S9: Fix DX mode parser not turned ON. Fix mistake if DX call prefix not found in the DXLOC.txt file. Fix DXLOC.txt file (some mistakes). You will need to copy over the DXLOC.txt file Fix: 5kVU module now allows you to alter/save the LO Error Khz setting (just like the external Xvtr's
2-15) Fix: Map by Band now does show all spots on map for the entire band, not just your panadapter width. Fix: SWL bands for those with extended capabilities Fix: DXLOC.txt seperate out USA country into USA0-9 Fix: Deleting Freq from VFO entry causes crash 04/08/16 S9: Fix Mapping/Grayline code mistakes wasting too much cpu time. Fix: turn
off DX mapping if you dont have the DXLOC.txt file in place. Fix if socket shuts down, you can get out of it without restarting PowerSDR. Fix certain freq spots where SWL spots disappear from screen. Update to latest SWL.csv and DXLOC.txt files. 04/07/16 S8: Add Ability to Filter out CW, Digital, or Phone DX Spots Add Country to DX window. Fix
DXLOC.txt file 04/06/16 S7: Fix: DXLOC.txt file Fix: Brighten up the map slightly Fix: Parse the Grid out of the comments for freq > 50mhz 04/05/16 S7: Add ability to log into Reverse Beacon Telnet cluster, like: telnet.reversebeacon.net PORT 7000 Fix: To avoid congestion only spots in your Panadapter will show up on the map (if selected) Fix: SWL
spotter loads instantly now. Fix: Keyboard shortcut issue, caused by touching the waterfall ID callsign box. Fix: mistakes in the DXLOC.txt file Fix: Dont use reported spot UTC value, use your own UTC value for age determination (prevents spots from being wiped out) Fix: Gridlines on/off not saving properly at powerdown when Track ON Fix: Make
special panafall waterfall area slightly smaller to view almost entire map YouTube Video Describing RevS7 : 04/04/16 S7: Add Call signs OR Countries Directly to Map itself (in proper Lat/Lon position). Add Red dot(s) on map of countries in DX Spot list Right Click on the Callsign window in PowerSDR to open the database folder. Now copy over the
DXLOC.txt file (found in the ZIP file) to the database folder (drag and drop). Now you have the DXCC list of countries by prefix and lat/lon. Its a work in progress. 04/03/16: Fix DX spot age 04/02/16 S6: Add: Special Panafall mode for Sun/GrayLine, 80% Pan, 20% Water only for RX1 (best of both worlds). Fix: Sun/GrayLineOn its own Thread so DX
spotting does not need to be on. Fix: Recall color and alpha on startup for GrayLine. Add: Grid lines turn off in Sun/Grayline mode, and turn back on when off Fix: reduce thread cpu time. Gray Line shows what is technically knows as Sunset (lighter area when the sun angle is greater than 90°) and Civil Dusk (dark area when sun angle is greater than
96°) 04/01/16 S5: Rework SUN/GRAYLINE code so it redraws into the background image instead of the display. This eliminates the CPU time wasting caused by adding items to the display code. The nice side effect is that everything drawn into the display automatically draws over the top of the GrayLine. Also doubled the resolution of the Gray Line
for a better image. ADD: GrayLine color and Alpha can be selected (right click on Center button). New : SWL.csv file update from eibispace.de YouTube Video Describing RevS5 : 03/31/16 S4: Add: Gray Line option in the DX spotter (in addition to the Sun Track option). Add: SFI and A-Index next to Sun (from daily NOAA space weather report)
Embedded an Equirectangular Projection map that automatically overrides your current image, when either Sun or Gray Line is enabled with DX spotting ON. You probably want to run this with Grid Lines Off. Again thanks to Dick W3WVG and Roland Leigh. Fix: Darkened the night area more 03/29/16 S3: Add: Sun Tracker when using the
"KE9NS6_World skin" (download from this page below) and only when the DX Spotter is ON. World skin I Photoshopped is a Robinson Projection that I darkened to allow for easier viewing of the Panadapter, however I scrunched it (vertically) to properly fit the Panadapter proportions. Lat and Long lines are all 15° spaced. The Sun image is embeded
in PowerSDR and should track Lat based on the Day of the year and Long based on UTC (Right side is 2359 UTC , Left side is 0 UTC, Center is 1200 UTC). I will try to add Grayline. Work in Progress. If you resize PowerSDR window, it could take up to a minute before it does its next update and moves to the correct position on the map. I may need to
change the map projection to make grayline easier. Received some Grayline help from Dick W3WVG and Roland Leigh Fix: try to fix catching QSX or QRX splits 03/27/16 S2: Add: Adjustable TNF notch width (right click on TNF). Was 100hz. Now you can set up to 600hz. Instead of creating multiple TNFs to cover up a noise. Also, Factory Resets for
NR and ANF settings. YouTube Video Describing RevS1 : 03/26/16 S1: Add Rec/Play ID checkbox: PLAY will Key radio and play last Audio recorded (or last audio file selected) and unkey when done. REC will set Drive to 0, Key radio to record yourself. Add: DX Spot Parser: parse out comments section and freq to determine Op Mode and Split (work in
progress) Add: DX spot age timer (on right side of DX Spot window). Fix DX spots update age better Fix: ClickToTune feature not selecting the correct VFO when both RX1 and RX2 on. Fix when RX1 and RX2 both on but RX2 Display is OFF. Fix: Rx2 Pan avg (when RX1 in Panafall) was not correct. Fix: Allow DX spot window to grow if you stretch the
window size. Fix: Rx2 dislay off with mousewheel Add: more Dx spot parsed modes: split,ssb,cw,am,fm, psk,rtty,olivia,sstv,packat,jt65,mt63,drm, Add: click on Spot DX a 2nd time to close, but when you click again to reopen it will continue to use the old spots (you dont loose the last spots now) unless you change the DX cluster node Add: Smother Dx
window update screen. Add: Pause dx window button YouTube Video Describing RevR12 to R1: 03/11/16 R12: Fix DX spotter timeout routine (was timing out wrong spots). Add more Right Click functions for the RX/TX EQ, NB,NR,ANL 03/22/16 R11: Fix Fix Grid display for over 50mhz. Fix Spotter issue after adding around Spotter 03/21/16 R11: Add
SWL Spot hyperlinking to Google. Click on SWL Spot and hit the CTRL key to open up Google to search the SWL spot. YouTube Video Describing RevR10: 03/21/16 R10: Add: QRZ hyperlinking on DX spot on Panadapter (Click on the Call sign, then hit the CTRL button, or Hold CTRL + Right Click together). Add: Press Shift key to Show Spotters on
Panadapter (toggle), release to go back to DX Spots Fixed DX spotting (multiband issue). Add "Keep on top" to Spotter and Scanner forms. Fix dx spots correct freq on fractional khz. Change AF to MON when transmitting to make it clear the function of the slider has changed during transmit. 03/19/16 R9: Add: Right click on Transmit profile to open
up Setup->Transmit panel Add: Click on RX1 or TX or RX2 antenna display to open up Antenna panel Starting to add a Band scanner. Uses Band you are currently on and starts with Default band edges, but you can override them. Stops when reaches High end or signal > Squelch slider level (squelch does not need to be on). Fast scanning wont catch
signals. need to keep it slow. Work in progress. I want to use the waterfall history to detect signals to stop at instead of the squelch level. 03/17/16 R8: Add: Left click on any DX Spot in the text window and go to that frequency directly. Note use the top of your cursor as the point to the spot, I need to reduce the cursor size) Add: Right Click on VAC
buttons to open up VAC panel directly, and auto focus on I/Q checkbox [hit space bar to toggle on/off]. Redo socket stream reader. Fix DX spot text window not removing dups. 03/17/16R7: Hopefully Fix correct reading TCPIP and Text file for Regional/Culture differences. Learn something new everyday. 03/16/16 R7: Add DX Spotting to RX2 as well as
RX. Now you can click on the DX cluster status line "Spotting" to check if you still have a live connection. Fix mistake in exclude NA spotters. Add Grid square just below call sign for spots > 50mhz. Any Exception Faults will show up in the text window for diagnostics. Fix mistake that dropped first DX Spot when the 2nd was received. YouTube Video
Describing RevR6: 03/15/16 R6: Fixed the CPU loading even after the SWL spotter finishes loading all 12k spots. A loose "Thread". No longer need the DX cluster name and dont need to worry if the Echo is on/off. Will show DX spots on 6m and Vhf and Uhf 03/15/16 R5: working on reducing the cpu load for the SWL spotter routine. Turn off SWL spot
when transmitting. Turn off SWL spots over 30mhz. Its a work in progress. Note: currently DX cluster must have echo turned on to work. 03/13/16 R4: Add SWL Spotter using the CSV file downloaded from . Rename the CSV file to: SWL.csv (Please: If you like this feature you should consider a donation to eibi for the work creating this database file.)
SWL Spotter Still needs tweeking, but it works. SWL.csv file is 12000 SWL records so it takes a while to read into memory, but it starts at 16khz and works up HF band, so the Panadapter will instantly show SWL spots that are on, and fills up the Panadapter starts in the LW and working up to 30mhz. It can take 1min to fully load. But many SWL
stations are beaming to other parts of the world (this list has that information) so I need a way to remove spots that cannot be heard at your location. YouTube Video Describing RevR3 to P3: 03/13/16 R3: Fix: Dx Spotter, checks for Spot dups (takes last unless same call on different bands then it leaves both), Freq dups (takes last spot), Spot timer
(drops spot after 30min from the last spot of that particular station). Draw Vert lines first so Calls go over Vert lines.. Almost finished with SWL spots. Data now loads and is parsed ready to display. 03/12/16 R2: Add: NOT FINISHED: SWL spotter using who provides a SWL database in the form of a CSV datafile. You need to rename it SWL.csv. It
checks the UTC time and Freq for a possible match on the Panadapter in the SWL bands. Fix DX dup inband outband. I think I have the DX Cluster formatexception crash under control? 03/11/16 R1: Add Spotter has its own window with spot to enter call sign, DX Spider node name, address, and port# Newest Spots always remove older Dups in both
Frequency and DX call. Added buttons to filter NA Spotters or exclude NA Spotters. Still working LSB Bands show Spots on Left side of Freq line, USB Bands show Spots on Right side of Freq Line. Still trying to track down a FormatException error that can make PowerSDR crash (it crashes with causing any problems) 03/11/16 Q9: Fix DX spot is now
the DX spot. Fix FILO buffer for 60 spots. Need to see if I can use a ring buffer for this instead? 03/10/16 Q8: Add DX Spots to panadapter (This is a rough working version of what I want it to do.) You can view all the spot from the Scanner button window still. I have a lot to fix, plus I want to add SWL to the spotter list. Currently after 100 spots, it
resets the Panadapter but not the Scanner window. I lots of work to do (check for duplicates, call sign collisions on the screen, etc) For the DX Cluster setup: The best thing to do in HRD (Ham Radio Deluxe) is to make sure your Call sign has logged into 2 different DX Spider nodes at least 1 time. In HRD select node: spider.ham-radio-deluxe.com &
Port 8000 and login at least 1 time. Now In HRD go to View->DX Cluster->Options->Connections: Select another DX spider node (for example: K1RFI.com & Port 7300) and connect to it in HRD and then leave HRD set to that node. Also, You can also setup both your DX Spider accounts to only show DX Spots that you want to see when your logged in,
otherwise you may see many spot you dont want to see. Now PowerSDR can use the spider.ham-radio-deluxe.com"HB9DVR-9 as its DX spotter and it will not prevent you from using the HRD DX Cluster. 03/08/16 Q7: Add SWL bands to Antenna->Expert, Add: testing DX spotter: First, your CALL SIGN must be in the "spider.ham-radiodeluxe.com"HB9DVR-9. Google for help. But beware since I am using the HRD spotter, you cannot have the Spotter open in 2 places at the same time. Enter your CALL SIGN into Setup->General->Options->Custom Title Text Click on the Spotter button on the main screen to start the DX spotting. Next Rev, the Spots will appear on the Panadapter by
frequency and I will choose another DX spider. 03/07/16 Q6: Add: Add to Band Stack by & Right Click on Band Button. Add: See Band stack "Index" and "Total" indicators under tune step. 03/06/16 Q5: Add: Drag/Drop File to Memory (copies the file name and location to memory). Right click to open file. Add: click on Temp a 2nd time changes Temp C
to Temp F Fix VHF panel and VHF output due to mistake when adding SWL bands YouTube Video Describing RevQ4 to P3: 03/05/16 Q4: Add: Save and Recall a URL web address from your Memory list. Save: Select a Memory, now use your mouse to, drag a browser URL address to the Memory window and Drop it anywhere. The URL is now added to
the Memory you selected prior. Recall: Right Click anywhere on the Memory row to open a web browser to the saved URL for that Memory. You can also Drag/Drop and create a new memory at the same time by Dropping the URL onto the ADD button Fix: Tweek Signal calibration on TR7 signal meter. YouTube Video Describing RevQ3 to P3:
03/03/16 Q3: Add: QuickAudio PLAY File selection (if Wave->Quick Audio Save Folder is enabled). After you make at least 1 recording, RIGHT CLICK on the PLAY button and select the file you want to play (Clicking Cancel will set back to normal, playing last recorded file). Then PTT or MOX and LEFT CLICK to PLAY as normal. This way you can
quickly make a bunch of recordings and then select any one to play back (easier than going through the Wave menu). Add: Frequency change automatically selects the proper Band button (HAM or SWL) 03/02/16 Q2: Add: QuickAudio Folder option (under Wave menu Item). When checked saves QuickAudio in QuickAudio subfolder and sequentially
numbers files. Right Click on REC button to go to main folder. Add: add tooltip SWL data to new SWL bands. 03/01/15 Q1: Add: SWL Bands (under the GEN band button), complete with bandstacking for everyband: LW/MW, 120m, 90m,75m,60m,49m,41m,31m,25m,22m,19m,16m,13m,11m. Auto creates (Copies over your current working database
into the new database) a new Database.xml with a RevQ in the name, and leaves your original database.xml file intact, so you can still run the old PowerSDR if needed. GEN SWL BAND buttons and panel, use the VHF BAND buttons and panel .png files. 02/28/16 P10: Continuum Display mode (Peak Power vs time) rx or tx, "Auto Wtr Level" changes to
show span (in khz) of display used for Peak power calc. If you click the span khz it will restart the Display. Time stamps update every 5 seconds. 02/26/16 P9: Reduce MON audio level of the TUNE signal in your headphones (AF MON level / 8). Add: Continuum Mode to waterfall (not finished) 02/26/16 P8: Fix mistake in RX2 display (cpu time waster
mistake). 02/25/16 P7:Fix TX panadapter min value. Forgot I never added a TX panadapter Low value, just a waterfall TX low value 02/25/16 P6: Fix: MON on/off with quickplay. Add: Toggle to turn on/off Panadapter Grid lines. Add Freq Scanner form page. 02/23/16 P5: Add: MON toggle between MONpr (Pre-Processed monitor) and MONps (PostProcessed monitor) for 3000 and 5000. 02/22/16 P4: Add: MON (pre-processed audio) to AM/FM for Flex1500 only in VAC mode though (not through the PHONES jack on the 1500). 02/20/16: P3: Add: MON (but pre-processed audio instead of post-prosessed) to AM/FM modes for Flex3000 and Flex5000. Add: turn off DoScope() if your not actually
using it to save cpu cycles The MON is normally turned OFF for AM/FM modes. I enabled it for AM, but the MON output in the speakers, headphones, VAC is modulated AM (to the edge of the passband), this is because MON wants to use post processed audio. I will need to use pre-processed audio for AM/FM mode, so its not the audio you are
transmitting, but at least the MON function works now. YouTube Video Describing RevP2 to A1: 02/18/16 P2: Add: Auto Waterfall Transmit Low level adjustment. Key the radio and Click "Auto Wtr Level" to set Waterfall for transmit input level. Fix: Waterfall only, not displaying correctly due to addition of avgP, avgB previously. Auto Wtr Level turns
off if you just in panadapter mode. 02/18/16 P1: Add: Auto Waterfall Low Level Adjustment. Just click the "Auto Wtr Level" button below the display area. 02/17/16 O9: Fix: Found mistake in Source code when compiled under VS2015 caused the check for atu.dll to fail, so Flex3000 units were using OLD ANT Tuning algorithm. Also Dttsp.dll now is
updated to current 2015 v140 toolset, hopefully no issues. I embeded vc_redist_x86 into the DttSP.dll. 02/16/16: Figured out how to compile DttSP.dll under v140 platform toolset. Dumpbin showed v140 requires vc_redist.x86 since DttSP is a 32bit C application. Recompile DttSP.dll under C code generate runtime /MT (instead of /MD) will include all
required DLL's 02/15/16 O8: Fix: Add toolTips to TXWaterID and Callsign box. Save the AvgP or AvgB settings in database. Right Click on Callsign Box to open up Folder where you put your own bitmap files to send to the waterfall. Right Click on the REC button to open up Folder where you will find SDRQuickAudio.wav files from your REC / PLAY use
Right Click on the your current skin (Setup->Appearance->General->Skins->current skin) to open the Folder to the SKINS . 02/14/16 O7: Fix: Prevent (if you accidently hit the TX Waterfall ID with the Radio OFF) keying the Transmitter when the Radio is OFF (sitting idle) 02/13/16 O6: ADD: Flex3000 Now has 192k Sample Rate (you can view around
170khz on the screen at 1 time), in addition to the 10khz wide TX 02/13/16 O5: Fix: TX WaterID Now runs on its own background Thread (see video).Creates file when you change the Callsign text field. 02/12/16 O4: Fix: TX WaterID much faster to create image if running 96k or 192k Sample rates. Fix: Flex Audioplayer has a automatic resampler, but
the code to make it work had some missing pieces, fixed the missing pieces, so now 48k waterfall resamples for 96k and 192k SR. 02/12/16 O3: Fix: TX WaterID labels: Creating->Transmit-Tx WaterID. Add Grayscale to database. Database name now: ke9ns1.dat 02/11/16 O2: ADD: Database to save mod settings: Callsign ID, Wide waterfall, etc.
02/11/16 O1: PowerSDR compiled under NET 4.5.2. PowerSDR.exe file slightly larger because Cdecl requires each function to have its own cleanup code. The Downside is that you must also copy over a "PowerSDR.exe.config" file becuase of the old FLEX1500USB.dll. NET 4.5 is supposed to be an improvment over the NET 3.5 PowerSDR was using.
02/11/16 Start learning DttSP: Update C++ code to VS2015 and recompile to SDK 8.1, which causes struct redef caused by time.h using timespec and pthread.h using the same timespec,but tv_sec is declared long instead of time_t, so I turned off the pthread.h version for now. also determined that not all of the DttSP is here. Completed full upgrade
to NET 4.5 using CallingConvention = CallingConvetion.Cdecl in the DLLImport lines of win32.cs and dttsp.cs. Small change to app.config, set VS2015 to NET4.5 and recompile. (thanks to WA1GON for figuring it out) But also determined that you need to bring a config file along with the exe file due to an old DLL 02/11/16 N7: Fix KHZ freq entry.
Turn off KHZ entry for VHF and above freq on both rx1 and rx2. 02/10/16 N6: Fix: Increase TX Bandwidth on Flex1500 and Flex3000 to 10khz wide. Fix: Improved Waterfall ID 24bit bitmap transmit. Automatically reduced the TX High filter down to 2.6khz during transmit, then back to its prior value. Still learning Bitmaps, and PCM and the
conversion between them. 02/09/16 N5: Add: Waterfall ID will now load standard 24bit bitmap files as well as 8bpp 256 color bitmap files. 02/08/16 N4: Fix: VAC1 will automatically turn off when sending a TX waterfall ID, then back on when done. Add: Transmit 256 grayscale 8bpp bitmap images. Instructions: 1) Create a small 8bpp 256 color or
grayscale bitmap image around 80w x 60h pixels and call it a short name, for example: test.bmp 2) Place that file in the folder %userprofile%\AppData\Roaming\FlexRadio Systems\PowerSDR v2.7.2\ (where the quickplay audio files go) 3) Change the "callsign" to the name of the file with a . at the end of the name (for example: test. ) and it will load
test.bmp from the folder and send it. Warning: There is no file checking. If you do not follow these instructions, PowerSDR will crash. Your database should survive, as my database did. I provided a "test.bmp" file to place in the folder mentioned above. 02/08/16 N3: Fix changing LSB/USB needs recreate waterfall ID image 02/07/16 N2: Fix image was
2.4khz but started at 250hz, now starts at 150hz 02/07/16 N1: Feature ADD: First attemp at: WaterFall TX CALLSIGN ID. Click the TX Water ID, and the Radio Transmits your Callsign as a Waterfall image that any SDR with a waterfall can see. You change your callsign from the menu item Callsign. Reduced Bandwidth of transmission. Code
Developed: Wrote code to convert text string into a bitmap image (grayscale or b/w). Wrote code to convert bitmap image (from file or memory) to digital PCM (any size and any Sample Rate) Wrote code to save digital PCM as .wav file (any SR, mono or stereo) Wrote code to copy digital PCM into Flex Quickplay routine (only issue is the bitmap to
PCM conversion time at 192k SR. Need a way to allow lower SR when operating Flex Radio at 192k SR) How it works. 1) Type your Callsign into the box Callsign. 2) For TX on VFOA: VAC1 must of OFF, you can use VAC2. You cannot use VAC1 or 2 if you TX on VFOB 3) Click on the TX Water ID button to create and send the Waterfall ID4 4) The 1st
time you click, there will be a noticable delay (very long delay at 192000) while the image is created before sending it, you MIC will be ON. 5) Subsequent Clicks on TX Water ID will start instantly (unless you change sample rate or callsign or mode). 6) The audio level can be controlled by going to the WAVE-> TX Gain adjustment. 7) Lower sample
rates create the initial image faster, so less delay on the first click. 8) Bandpass is around ~ 2.4khz wide starting at 150 hz 9) If your running 192000 samplerate, you will not see a very clear waterfall image. This is because there are only 4096 point to display around 170khz worth of information (~40hz per pixel). It will still transmit clearly. You can
only view waterfall images clearly at 96000 or 48000 sample rates 02/04/16 M10: Fix: I believe the studder in DJ console might be related to the PA temp/volts display which take .05 seconds to read and display. Made the Temp/volts display off by default, click on it to turn it on. It updates with the CPU, so whatever you set as the CPU Meter refresh
rate is the refresh rate of the temp/volts when its ON. 02/03/16 M9: ADD: Check box in Setup->Display->Waterfall-> Enable Wider Waterfall. When checked this Increases waterfall bitmap size by factor of x2. By widening the waterfall left/right, you must go further up or down frequency to hit the edge of the bitmap. Hitting the edge causes a need to
refresh the bitmap (which causes the deley ). The standard moving waterfall draw take ~.015 seconds, the wider waterfall takes ~.022 seconds. Older computers may by laggy with the wider waterfall area. Recompiled under VS2015 UPDATE 1. Font: Found somehow all console fonts got changed to MS SanSerif "Oblique". Trying to change back to
"Regular". Swis721 is only for on the Meters. 02/02/16 M8: Feature ADD: On TX readjusts Panadapter Grid to span -90 to 0db, on RX Grid resets back to Low/High settings. 02/02/16 M7: Feature ADD: "Avg" button in Panafall affects Pan & Water. Now you can toggle have Avg Both, or Avg Pan fixed waterfall issue on resize of powerSDR window.
02/01/16 M6: Fix waterfall move on RX2. 01/31/16 M5: Fix clicking on meter now saves that meter for the next powerup. And learning some of the moving parts. 01/30/16 M4: Fix Flex mistake setting RX2 preamp offset to +14 (sometimes) when it should be -14 (just like RX1 on high mode). 01/30/16 M3: correct crashing issues caused by me going
between VS2010 and VS2015. 01/29/16 M1: Fix blank space at bottom of screen caused by not copying the embedded font into the output directory 01/29/16 M: Feature ADD: DJ console 01/29/16 L8: Fixed Emedded Font compatibility issues with Win7 computers. (had to do with multiple fonts and not writing them properly into the
privatefontcollection. 01/28/16:L : Feature Add: Freq Entry in KHZ or MHZ. (720 = .720 mhz) (7123 = 7.123 mhz) 01/28/16:K10: Fix: Digital display above meters, shift left 1 space for new font. Put Rev history in the About panel 01/27/16 K9: Fix: embedded the standard Windows Swis721 Font series into PowerSDR.exe. Enlarged the Edge type meter
face. 01/27/16 K8: Feature Add: click on RX1 meter to change meter style. Fix edge meter size changing. 01/26/16 K7: Fix:RX2 low level band dBm following what you saved for the RX1 low level band dBm 01/26/16 K6: Fix:Edge meter red number too large. 01/26/16 K5: Fix:High level on TX Waterfall automatically sets to 0 db (you set the TX Low),
since 0db is what your trying for anyway. 01/26/16 K4: Fix:Clean out areas of waterfall bitmap no or bad data. 01/26/16 K3: Fix:Turn off temp/volt on Flex 1500. Sometimes waterfall didnt move correctly due to timing issues between freq change and bitmap creation 01/25/16 K1: Added ATU.DLL to resources. This should fix Flex3000 ATU not showing
up. 01/24/16 K: Now the entire Waterfall for both RX1 and RX2 moves with the spectrum of the panadapter. This leaves gaps on the left/right as you scroll since there is no data in those areas, but the waterfall will fill them in. This feature is not perfect, If you change ZOOM levels, it will not follow. 01/24/16 J: Add temp and volts to main screen, it

updates along with the CPU% (hopefully calling FWC wont mess anything up?). Corrected the POWER on the TR7 meter by modifying the alg. Corrected the text and numbers on the Analog meter. Changed the FONT from the bla "Arial" and "MS Sans Serif" to the nicer "Swis721 BT" (italic). This I believe is the exact Font used by Icom on their
displays. 01/23/1 I: Add Signal Peak hold meter for RX1 and RX2 meters (2nd red hold peak line) and db numbers hold peak with 2nd needle. Also corrected S9 readings for > 30 mhz to -93dbm 01/21/16 H: Add Menu item on the top line of PowerSDR for toggling Grayscale and Color for waterfall. Found Grayscale cuts the bandwidth down needed for
remote operation. Also added toggle on/off fuction to Peak offset, Peak Power, Peak Freq values in lower right corner of display by mouse clicking any of those values. Also added hover tips to them. 01/18/16 G: Fix the RX1 or RX2 waterfall size messing up when you expand or shrink the PowerSDR console size. 01/17/16 G: Clean up and smooth the
Analog meter lines (arcs). Now Analog meter movement(s) for everything except RX ADC(s). Renamed Waterfall "Mic Level" to "TX Level" since its not just for the mic input. 01/16/16 F: Fix Flex mistake displaying CW TX spot on both RX1 and RX2, when it should just be RX1 or RX2. Added additional TX meters (i.e. ALC, Mic) 01/15/16 E: Now you can
set the Waterfall Low Level for both RX1 and RX2. Now can you can set the Transmit waterfall low level seperately from RX1/RX2. Note that RX2 and Transmit low levels dont save in database like RX1 (until I figure out how the database works), but RX2 does pull the data for the band your on from the RX1 database, so its not a big issue. 01/15/16 D:
Added Panafall mode for RX2. RX1 can run Panafall with RX2 in any mode, but RX2 Panafall will not enable unless RX1 is in Panafall as well. 01/14/16 C: fixed turning RX2 on/off causing issue in window display. 01/12/16 C: Worked in the RenderGDIPlus routine: Created/Enabled Panafall on RX1 to stay on with RX2 enabled. 01/10/16 C: Fixed meters
not updating with RX1 or RX2 off by using .Invalidate() 01/09/16 B: Fix missing CW panel. Fix button panel spacings between RX1-Band-Mode-Filter-RX2 panels. Added new RX1 meters to RX2. 01/08/16 A: Found way to turn off RX2 for testing Single receiver Flex radios. Corrected display of Flex radios with only 1 receiver. 01/07/16: Initial release:
Worked in MultiMeterDisplayMode: Created routine to convert linear Flex "pixel_x" values to Angle 0-180deg. Created routine to convert angle to Radians for graphical display. Removed Flex "Original" bargraph meter, added "Analog TR7" meter movement, and adding 3rd "Analog" mathmatically generated meter. FlexWire I2C or IIC Bus 8bit
address (not 7 bit) list for FlexWire output: 0x40 HERO's preselector 0x42 Band selector output for PCA9534 (1st) 8bit I2c chip (2200m=1 - 20m=128) 0x44 Band selector output for PCA9534 (2nd) 8bit I2C chip (17m-6m) 0x46 Band selector output for MCP23017 16bit I2c chip (2200m-6m) 0x48 Not used 0x4A LDMOS Amp Filter board selector
PCA9534 (w6pql current design) 0x4E LDMOS Amp Filter board selector PCA9534 (w6qpl old design) 0x4C UCB (Universal Control board) Relay selector. PCA9555D (part of the Xvtr panel) Click here for more information on I2C (IIC) data Flexwire I/O connector is a DB-9 female serial type connector wtih pin 3 blocked so you dont try to plug a serial
bus into it. DB-9 connector view from back of radio: ( 6-7-8-9 ) (1-2-3-4-5) 1: Ground 2: Line In 3: Blocked 4:/INT1 5: Ground 6: IIC CLOCK (SCL) 7: IIC DATA (SDA) 8: +13.8vdc out (1A max) 9: Line Out IIC bus uses pin 5,6,7 low speed (100khz) bi-directional synchronous data bus. IIC bus allows multiple devices on the same bus where each device has
an address 8bits long. Important NOTE: example: 8bit address 0x46 = 0,1,0,0, A2,A1,A0, 0 = (01000110) (bit0 determines Read/Write but its still part of the address byte) --------------------------------------------------------------------------------------------------------------------------------------------------------------- KE9NS added I2C (IIC): Setup->General->User Interface->I2C Band
Output checkbox Upon band change, PowerSDR will send 2 IIC command strings: (For PCS9534 I2C port replacement chip) 1) 8bit Address 0x42 Register 0x01 Value = 2) 8bit Address 0x42, Register 0x03, Value = 0x00 (below) 2200m = 1, 630m = 2, 160m = 4, 80m = 8, 60m = 16, 40m = 32, 30m =64, 20m = 128 ------------------------------------------------------------------------ (For PCA9534 I2C port replacement chip) 1) 8bit Address 0x44 Register 0x01 Value = 2) 8bit Address 0x44, Register 0x03, Value = 0x00 (all output) (below) 17m =1, 15m = 2, 12m = 4, 10m = 8, 6m = 16, reserved = 32, reserved = 64, reserved = 128 ------------------------------------------------------------------------ (For MPC23017 I2C 16bit port
replacement chip): 8bit address 0x46, register 0 & 1 to 0 (all output on PortA & B) 8bit address 0x46, register 0x12 8bit address 0x46, register 0x13 -------------------------------------------------------------------------------------------------------------------------------------------------------------- UCB (FlexWire Button) using PCA9555D IC Open on XVTR page, you will find a FlexWire button
OR + + U: "UCB" Universal Control Board Configuration page Note: When FlexWire Button is "Yellow" then the IIC output is active See page: k3tuf.com/FW.html , for info on FlexWire and UCB This is used in conjunction with the XVTRs menu and the VHF+ button on the main PowerSDR screen On the XVTR menu enable a item and give it a UCB
Line Number. This corresponds to the above screen. You then select which relays activate for each UCB line number. The VHF+ button on the main screen is how you access this new band. UCB transmits via IIC bus the following 4 sets of 3 bytes (PCA9555D): 0x4c, 0x06, 0x00 0x4c, 0x07,0x00 0x4c, 0x02, (low 8bits value of line#) 0x4c, 0x03, (high 8
bits value of current line#) ZZFY CAT command can be used to send a I2C command (address and 2 bytes of data). This can be used to program any I2C IC --------------------------------------------------------------- The HERO preselector menu button sends a address = 0x40 with 2 bytes of data representing the Band and Ant selected from that HERO panel. Current
HERO Preselectors have a USB connection to CAT and no longer need the I2C output. --------------------------------------------------------------------------------------------------------------------- KE9NS Amplifier control using IIC Activate the feature from: Setup->General->Options->Use IIC FlexWire for External AMP Control, and Setup->General->Options->IIC FlexWire AMP
ON/OFF checkboxes. Upon Band Changes the following 6 bytes of data are transmitted via IIC bus Older W6PQL LDMOS RF Filter Design (address 0x4E) 0x4E, 0x01, 0x4E, 0x03, 0x00 Current W6PQL LDMOS RF Filter Design (address 0x4A) 0x4A, 0x01, 0x4A, 0x03, 0x00 : 1 = Select bands: L/MW, 160m, 120m (no relay needed with W6PQL design
filter board) 2 = Select bands: 90m, 80m, 61m, 60m, 49m 4 = Select bands: 41m, 40m, 31m ,30m 8 = Select bands: 25m, 22m, 20m, 17m, 16m, 15m, 14m (Address 0x4E only) 16 = Select bands: 13m, 12m, 11m, 10m (Address 0x4E only) and 8 = Select bands: 25m, 22m, 20m, 17m, 16m(Address 0x4A only) 16 = Select bands: 15m, 14m 13m, 12m,
11m, 10m (Address 0x4A only) 32 = Select bands: 6m 64 = Remote ON/OFF (used N.C. contact... 64 relay on = remote control) 128 = Selected bands: VHF/UHF (bit7 is turned OFF) bit6 (64) is SET only if IIC AMP ON/OFF checkbox is set and on an HF/6m band See my SS AMP page for controller board circuit Digital Decoders (with further detail in
the next section) All decoders tested with the Flex unless stated otherwise Audio stream via VAC (Virtual Audio Cable) and Firewire connection (no audio cables required) There are many digital signals present throught the HF band, however most outside of the Ham bands use special digital modes and/or are Encrypted See website for signal indent
guide: Even better is "Artemis Radio signal detection" program you can run from your PC. Download at: ------------------------------------------------------------------------------------------------------------------------------------------------ DREAM.EXE (Digital Audio decoder): Click here DReaM_v2.2.1_zefie1.1_xHE-AAC_FDK_Win8.1_x86 to Download the latest v2.2.1 (compiled with VS
and QT5.12.0 and works with xHE-AAC support). The new version of DRM allows for lower bitrate requiring lower SNR You must also install NPCAP (new version of WinPCap) from here: This compiled version was posted here: FLDIGI.EXE (multiuse): CW,CONTESTIA,DOMINOEX, HELL, MFSK, MT63, Olivia, PSK, QPSK, PSKR, RTTY, THOR, THROB,
WEFAX, NAVTEX-SITOR5, WWV (Easy to use, TX & RX) SIGMIRA (multiuse): FSK,PSK31,SITOR-B,CW,HFDL, STANAG 4285, JSM (Easy to use, works well, TX & RX) (But requires a feature.dat date expiring file, which you can overide if you backdate your PC). Also, Sigmira will only see signals from the DEFAULT windows recording device. I selected
my virtual Line 1 as my output, then set it as default in windows. MIXW2 (multiuse): CW,BPSK31,QPSK31,FSK31,RTTY, PACKET, PACTOR, AMTOR, MFSK, THROB, MT63, HELL, FAX, SSTV (Difficult to decode in many modes, TX & RX) MULTIPSK (multiuse): Decodes just about everything, but very difficult to use, doesnt work very well. CLOCK
(from the creator of MULTIPSK): Decodes all the time signals on HF EASYPAL (images): DRM digital photos, Waterfall pictures (Easy to use, great waterfall, TX and RX) DIGIPAN (Ham Texting): BPSK31,BPSK63, QPSK31, FSK31, PACTOR(RX only) (Easy to use, multiple conversations at the same time, TX & RX) ALE (Automatic Link Establishment
message system): MIL-STD-188-141B, MIL-STD-188-110A,B (MARS-ALE difficult to control Flex, PC-ALE OK) RMS Express (Radio Message Server for email/message system): TELNET, PACKET, PACTOR, ROBUST PR, WINMOR (all as WL2K or P2P) (Easy to use, RX and TX) MMSSTV (Slow scan TV):
Robot36,72,AVT90,Scottie1,2,DX,Martin1,2,SC2,180 (Easy to use, need good signal, TX & RX) Download at: WSPR (weak signal contacts): (requires PC clock time synced) WSJTX (weak signal contacts): JT modes (requires PC clock time synced) WSJT (Version 10): JT modes + ISCAT modes + FSK441 (ISCAT B and FSK441 modes used on 6m 50.248
50.246) PC-HFDL: Airplane tracking (easy to use) SORCERER (multiuse): FSK, STANAG, RTTY, CW, (somewhat difficult to use) MSCAN METEO (weather): RTTY, NAVTEX, FAX, Voice (installed, but not tested) NAVTEX (weather): (installed but not tested) MMVARI (multiuse): RTTY, FSK, PSK, GMSK (installed, but not tested) FREEDV (Digital Audio):
(low quality audio, requires strong signal, TX & RX) WINDRM (Digital Audio): (installed, but not tested) FDMDV (Digital Audio): (installed, but not tested) HAMSCOPE (multiuse): RTTY, PSK,FSK (installed, but not tested) WINWARBLER: CW,PSK,RTTY (installed, but not tested yet) YaDD: DSC (Digital Selective Calling) for Maritime Mobile & Navtex
Links to Sounds Of Digital HF signals: Amateur FT8 (using wsjt-x) NOTE: FT8 has a rather large penalty on your CPU in a crowded band (like 80m and 40m) trying to decode 20 or so signals simultaneously. The more signals to decode, the higher CPU and HDD usage. My old 4 core cpu maxed out at 100% decoding on 40m and running PowerSDR at
the same time. I decided to upgrade my desktop motherboard to a 6 core (2 thread / core) and 16gb of DDR4. Now FT8 doesnt cause any troubles. USAGE: Weak Signal or Poor band condition, very short QSO, QSL Communications. (good for collecting mixed and digital awards and checking antenna performance). After you make a few contacts go to:
and type in your callsign to visually see (on a world map) where your signal is getting out). ENCODER/DECODER: WSJT-X (with JTAlert-X for checking QSL information and interfacing with your Logging software) and FT8 decode signals down -26dBm below the noise in 15sec sequences (up to 13 characters per sequence) with a typical 4 sequences
Use the TIME sync function in PowerSDR to sync your PC clock (must launch PowerSDR in ADMIN mode). Use vsgMgr, DDUtil, and Virtual Audio Cable to link PowerSDR to wsjt-x In wsjt-x radio setup use TS-2000 for now and set PowerSDR CAT to allow kenwood commands. When you see a RED or VIOLET CQ signal appear in the Left "Band
Activity" panel, click on it (Here is the awkward part:As soon as the CQ appears you only have 1-2 seconds to respond, otherwise you must wait for the next 15 second TX interval). Your Transmit appears in YELLOW on the right "RX Frequency" panel. If the CQing station decodes your call sign, you will see them calling you as a RED decoded line the
the Right "RX Frequency" Panel wsjt-x will automatically step through the sequences (after you start by clicking on the CQ station) for short QSL exchange (15 seconds per line): : JTAlert-X scans your main logbook and the wsjt-x logbook and automatically adds your contacts to your main logbook. And, it keeps track of what you need (Zones, States,
Countries, Grids, etc.) and alerts you immediately after every "Decode" MODE: Band Mode (USB on all bands). FT8 signals are 100hz wide found in a 2.5khz bandpass area FREQ: 1.840, 3.573, 7.074, 5.357ch3, 10.136, 14.074, 18.100, 21.074, 24.915, 28.074, 50.313 Mhz SOUND: Click to download audio file to hear what it sounds like (top left: signal
as it appears in PowerSDR panafall) (top right: wsjt-x encoder/decoder) (bot left: wsjt-x waterfall allows you to manually select a transmit frequency within the bandpass)(bot right: JTAlert-x reads the decodes from wsjt-x) WSJT-X SPLIT operation: Example: For FT8 with Japan, VFOA = 1908, VFOB=1840, TX=VFOB, Click VFO Lock button until it
reads "VFO A/B Loc" Then setup WSJT-X, TS-2000, SPLIT= NONE WSJT-X multi-instance operation: (For those Flex-5000 and 2nd receiver RX2 option) This is the normal WSJT-X Desktop ICON Property: C:\WSJT\wsjtx\bin\wsjtx.exe To create the 2nd WSJT-X icon (that can run simultaneously with your current WSJT-X Icon): 1) Open file location:
C:\WSJT\wsjtx\bin 2) Right click on the WSJT-X and send to ->Create Desktop shortcut 3) find the next WSJT-X shortcut icon on your desktop, Right click to rename WSJT-X2 4)Right click and select Properties and change C:\WSJT\wsjtx\bin\wsjtx.exe to say: C:\WSJT\wsjtx\bin\wsjtx.exe --rig-name=Flex5000RX2 5) run this WSJT-X and WSJT-X2 and run
setup to config as below (as SO2R): Left is VFOA, Right is VFOB (NOTE: Use JTAlert to automatically send QSO's to your logging program. JTAlert will automatically handle the 2 instances as long as you setup like you see in the next 4 screen shots) Keep the Baud Rate on both at 57600. the WSJT-X2 (on right) uses the COM23 because its paired iwth
COM22 in PowerSDR and that is the RX2 VFOB CAT COM link. I use VoiceMeeter Banana as 1 set of VAC cables (Left side) for the VFOA setup of WSJT-X. I use DAX drivers (from a SmartSDR install) as the 2nd set of VAC cables (right side) for the VFOB setup of WSJT-X You can see the VAC1 configuration for VFOA You can see the VAC2
configuration for VFOB You will need to alter the UDP server of the WSJT-X2 (VFOB) version to allow JTAlert to handle communicaing with 2 instances of WSJT-X WSJT-X on RX2 VFOB (one instance): (For those Flex-5000 and 2nd receiver RX2 option) Simply launch the "WSJT-X2" version and this free's up VFOA. CWSkimmer USAGE: CW signal
decoder PowerSDR and CWSkimmer Settings: 1) Assuming you already have VAC1 setup to work with your other digital modes on your PC, just click on the VAC1->Direct I/Q "Output to VAC" checkbox. CWSkimmer appears to only work with I/Q audio. 2) in CWSkimmer->View->Settings->Radio->Softrock-IF SR set to 192khz, Audio IF 9600 (This
assumes a Flex-5000. For a Flex-3000 set to your current SR (likely 96khz) 3) in CWSKimmer->View->Settings->Audio->set "Signal I/O device" to match your VAC1 4) in CWSKimmer->View->Settings->Cat->Radio 1->PowerSDR (and your CAT settings like you would any other PC Program) 5) CWSkimmer only appears to work with VFOA and when
your in CWU mode (not CWL) 6) Use PowerSDR->CWX panel (or your own Key) to transmit 7) Click on the little Radio icon in CWSkimmer (upper left corner) to start it working. 8) Remember to turn off the I/Q checkbox when your done, otherwise you will go crazy trying to figure out why FT8 doesn't work :) Commercial Broadcast DRM USAGE:
Broadcast audio Communications, and text DECODER: Dream.exe (free) Commercial DRM (difficult to setup the codec and requires strong signals) Signals must be over S9 to work. Any interfearance on top of the 10khz signal will prevent decoding. DREAM.EXE (Digital Audio decoder):Click here DReaM_v2.2.1_zefie1.1_xHE-AAC_FDK_Win8.1_x86 to
Download the latest v2.2.1 (compiled with VS and QT5.12.0 and works with xHE-AAC support) You must also install NPCAP (new version of WinPCap) from here: The new version of DRM allows for lower bitrate requiring lower SNR This compiled version was posted here: MODE: PowerSDR Mode DRM, otherwise USB 10khz wide will work. FREQ:
DRM broadcast schedules from around the world: SOUND: Click to download audio file to hear what it sounds like (LEFT: DREAM DRM program showing the radio Station. Make sure to adjust the PowerSDR audio RX output level so no RED appears in the vertical Green bar) (RIGHT: 9k wide DRM signal. Note the AM broadcast directly to the right is
the exact same broadcast in Analog AM) (below: Click on View->Evaluation Dialog. This is the setup you should use. The SNR "MUST" be at least > 16 dB. Wait for all Green boxes, then you will hear audio over your PC speakers) click on images to enlarge Amateur DRM USAGE: Still image, file transfer, chat, QSL Communications
ENCODER/DECODER: EasyPal.exe (free). Signals must be over S9 to work well. Files & Chat & Pictures: EasyPal with Hybrid TX is a free program for RX/TX Files/Photes in a 2.7khz bandwidth. Use E,2.4,HI,QAM4,24 for weak signals, QAM 16 only for strong signals. You can adjust the DRM speed to allow easier reception as a cost of transmission
time. Photos can take from 30 seconds to over 1 minute to send via HF DRM NOTABLE: HYBRID TX: Easypal saves your File/Photo on an internet server, then sends only the link via HF DRM. Saves time and allows for a weaker signal since it only takes a few seconds to send the link via HF DRM. Allows a big group to exchange audio, photoes, etc
without having to get email addresses or Skype names. MODE: Band Mode (USB/LSB) 2.7khz wide ( Notable Waterfall image is a solid 2.7khz line with dark shadows or stips that appear to barber poll ) FREQ: 3.713, 7.173,14.233 Mhz SOUND: Click to download audio file to hear what it sounds like (left: signal as it appears in PowerSDR panfall)
(right: signal as it appears in EasyPal) click on images to enlarge Amateur TV (SSTV) USAGE: Analog Still images, QSL card Communications ENCODER/DECODER: MMSSTV.exe (free) Need a strong signal to get a clear image. Video: MMSSTV is a free program to decode 9 different Analog still TV images. Download at: MODE: Band Mode (USB/LSB)
2.4khz wide (although the signal is typically around 1khz wide) FREQ: 3.800, 14.230, 21.340, 28.680 SOUND: Click to download audio file to hear what it sounds like left side: SSTV signal, right side: as it appears in MMSSTV click on images to enlarge Amateur Digital Audio DV USAGE: Digital Audio Communications ENCODER/DECODER:
FreeDV.exe (free). Need a strong signal to get audio (audio quality is sub-par due in part to vary narrow bandwidth) MODE: Band mode (USB/LSB) 2.4khz wide (although the signal is only 1.6khz wide) FREQ: Google FreeDV qso finder or look for the image below (14.236 mhz) SOUND: Click to download audio file to hear what it sounds like (this is the
1600 mode) (left: signal as it appears in PowerSDR panfall) (right: signal as it appears in freedv.exe) click on images to enlarge Amateur Olivia USAGE: Text based Communications ENCODER/DECODER: Multipsk Olivia MODE: USB 500hz wide FREQ: CW portion of ham bands SOUND: Click to download audio file to hear what it sounds like (left:
Multipsk) (right:PowerSDR) Amateur Contestia USAGE: Text based Communications ENCODER/DECODER: Multipsk or Fldigi MODE: USB125hz, 250 hz or 500 hz or1khz FREQ: CW portion of ham bands SOUND: Click to download audio file to hear what it sounds like Amateur Email (Winlink Express) PACTOR III USAGE: Email, File transfer
ENCODER/DECODER: Winlink Express (RMS Express) now using ARDOP_Win TNC You can also download an additional TNC: VARA HF or FM modem. MODE: USB 2.7khz wide FREQ: CW portion of ham bands SOUND: Click to download audio file to hear what it sounds like Email: RMS (Radio Message Server) Express is a free program for
sending/receiving digital messages (ie. email). 12/5/21 Winmor has now been depricated and the default is now ARDOP Win or you can download and install "VARA HF" and/or "VARA FM" as the modem in place of the depricated "WINMOR WL2K" If you see a Registration screen, just hit remind me later. Select ARDOP or VARA, then click OPEN
SESSION. Click setup on the WINMOR page to select the IN/OUT (use your VAC Line 1 & 2). Next. click Radio Setup and select Flex Radio and select the virtual COM ports for your Flex. Next, click Channel Selection to download the frequency listing and propagation updates, and the program will let you know which frequencies will work with the
current propagation and select a channel. Write a test Email back in the RMS Express window and click START back in the WINMOR window. The program will transmit a handshake to start the email transfer and will look to see if you have any email to be received as well. The entire tx/rx operation is fully automatic and will shut off when finished.
The ARDOP Sound Card window will show you what the program is doing. (RIGHT: you can see the constant TX/RX of data being transfered, just like TCP/IP) (LEFT: RMS Express open showing all the windows.) click on images to enlarge Amateur BPSK USAGE: Text Communication DECODER: Digipan MODE: USB 4khz wide (each signal is 200hz
wide , very narrow) FREQ: CW portion of ham bands (3.580, ) SOUND: Click to download audio file to hear what it sounds like (LEFT: multiple BPSK31 signals) (RIGHT: DigiPan decoder capable of tracking multiple signals (5 different types). The Green Flag indicates the conversation in the large window you are talking to. The other PSK streams are
simply shown as a single line on the left side of the screen) click on images to enlarge WWV or CHU Time/Date Decode USAGE: Time/date DECODER: PoweSDR T11 now decodes this. Clock (from the makers of multipsk). The free version will show you the correct time, but will not update your computers time. MODE: AM FREQ: WWV (AM mode) 2.5,
5, 10,15,20,25 mhz, CHU (ISB mode), and most otherTime signals SOUND: WWV: Hidden 100 hz from the carrier are the Second's pulses that are either short or long second pulses, you can decode this into TIme & Date. CHU: Between 31st and the 39th second, transmitted in a FSK ( USB) transmits the Time/Date. (Left: The Free CLOCK program,
Right: WWV signal in AM mode) If you want a free program to update your computers time (down to the second) download this file: Internet Time Update.exe Just put it on your desktop and run it. you can set it up to update every hour. Windows 10 makes it difficult to update your time down to the second. Noaa Weather Fax USAGE: Weather maps
DECODER: Sorcerer, MSCAN METEO, Fldigi, MixW2, Multipsk MODE: USB (around 3.5khz wide) FREQ: Varies (9.108, 6.3415, 4.3165 mhz) SOUND: Click to download audio file to hear what it sounds like (Left: The Free but not supported Sorcerer V1.01 with the Fax Decoder running, Right: HF Fax signal in the panfall, USB) NATO STANAG 4285
USAGE: NATO Communication DECODER: Sorcerer, Sigmira, Multipsk MODE: USB 4khz wide (signal is around 3.0khz wide) FREQ: Varies (8.4785,8.701 mhz) SOUND: Click to download audio file to hear what it sounds like (Left: SIGMIRA program to decode STANAG 4285 signals) You need to make sure the VAC1 out from the Flex is set as the
default RECORD source for SIGMIRA to see it. ALE (Automatic Link Establishment) USAGE: Freq Scanner for sending/receiving short messages (for ham radio or Mars) DECODER: ALE.exe (free), Mars-ALE.exe (free) You need to make sure the VAC1 out from the Flex is set as the default RECORD source for ALE to see it. MODE: USB 2.4khz wide
FREQ: Google for listing SOUND: Click to download audio file to hear what it sounds like SETUP: PCALE.EXE has a FLEXRADIO Rig to allow control of your Flex via CAT commands. You may need to use the "Default" playback and Recording devices instead of VB-Audio Cables. PCALE appears to be very buggy, and doesnt appear to properly do SPLIT
RX/TX operation. (Left: ALE.exe program to decode MIL-STD-188-141A or 110 signals) Notice the Vertical RED lines in the Tuning window when a 141A or 110 signal is present. DSC (Digital Selective Calling) & Navtex USAGE: Maritime messaging system DECODER: YADD.exe (for DSC), NAVTEX.exe, Fldigi, Multipsk, (for Navtex) MODE: USB 1.5
khz wide (NAVTEX: USB FSK 150 HZ shift, 100 Baud, CCIR476 character format) FREQ: 2.1875, 4.2075, 6.312, 8.4145, 12.577, 16.8045 SOUND: Click to download audio file to hear what it sounds like Shown below is the NAVTEX.EXE Shown below is the YaDD (yet another DSC) which if Free. This has the DSC frequencies built in and allows you to
receive Maritime Mobile Ship-to-shore messages. Searchable list of Navtex stations: Amateur 630m Band (472khz to 479khz) The Flex-3000 will output 100watts (actually 130watts but I would limit yourself to 100watts) on 630m, and the SWR / Power meters appear to function correctly, but the calibration is way off this far below 160m, so the DRIVE
level will be way off in relation to actual output. And you will need an external 630m LPF that can handle 100 watts. The Flex-5000 does not appear to be able to transmit more than a watt on 630m (in Extended mode). Power tappers off as you dip below 160m, so there is nothing remaining by the time you reach the AM BC band. FILTERS: The Flex1500,3000,5000 have no filtering below the 160m band (RX or TX). The 160m LPF is selected when below 2mhz. This means you will normally see many overload signals from the AM broadcast and 160m bands. IMPORTANT: You will need to add a LPF filter designed for the 630m band for both RX/TX (100 watt capable). This will not only filter your
Transmit harmonics, but also the AM broadcast and 160m signal overload that ends up flooding the Panadapter. IMPORTANT: When transmitting on 630m you will want to trim your TX profile low freq and high freq as narrow as possible to avoid transmit issues. (Example: low = 600hz, high = 2200hz) You will also need to be running in "Extended"
mode. FCC requires you first get permission, from your local power company, before transmitting. Or the direct application here: This is the response email I received giving me authorization to operate 630m band See for lots of info on 630m band. 1/14/22: Homemade 630m LPF for RX and TX operation (using parts I had around and vk6ysf for ref):
(2) ~16uH (16 turns of 14awg transformer wire around a 502T3003E2A toriod), and 562 (5600pf) 1kv caps (2 in parallel for the center, and 1 on each end to ground): You can see its 44db down at 1.6mhz. So when combined with my AM BC Notch Filter, the built in 160m LPF in the Flex radio itself, and my 630M LPF, this should clean up the RX and
TX You would be advised to make a LPF that is tighter with a cut-off at the AM Broadcast band. I put my 100 watt capable TX/RX 630m LPF into an aluminum project box (still waiting for my SO-239 panel mount connectors): Bucket Variometer loading coil for my G5RV in GMV configuration: 5gal paint bucket (29 turns of 14awg above and below the
1" PVC for max 600uH with 4 taps on the lower portion every 3 turns), (25 turns above and below the center of a 3" PVC pipe for 96uH of inductive buck). I can vary the inductance from ~200uH to ~600uH. 472khz.org says I should need around 400uH as a loading coil at the base of my G5RV converted to a T with ground radials. (below) Attached
the Bucket Variometer to my G5RV (shorting the PL259 as it connects to the ladder line). And utilizing the ground radials and ground rods I already had in place under the G5RV for my 160m switch. Attached the NanoVNA to the coax that would connect to my Radio. Easy to adjust the inductance by turning the end of the PVC pipe. With the LPF
inline, I can tune SWR for 2:1 on 630m. First 2 contacts running JT9 on 630m at 50watts from my Flex-3000 thru a LPF and my G5RV (with Bucket Varimeter and ground radials). Just found out that FST4-60sec interval is the more popular mode. FST4-120sec is for DX Typically you will hear "WSPR" and "FTS4-60sec" signals around 474.2khz (+800hz
to +1400hz). Download wsjt-x to decode and transmit.The FTS4-60 signal appears slightly wider than the WSPR signal. WSPR appears almost as a straight line. (above) WSJT-x showing both wspr and jt9 decodes, manually switching modes myself. (below) wsjt-x waterfall showing jt9 on the left side, and wspr on right side Since 630m requires a long
antenna, you will typically need a very large loading coil at the base of the antenna to tune the SWR flat (search 630m variometer in google) and keep the losses down. Note: These coils can generate lethal voltages with only a few watts on transmit. Receiver Birdies (Panadapter Bridies) The PowerSDR Panadapter exposes a whole set of new issues to
deal with in radio. When you open up the Panfall to 192khz, and adjust the waterfall color levels, you will see many signals across all parts of the HF band. Sometimes issues crop up and you start to see things that dont add up. All Radio's have their Birdies, its just on that on the Flex (with its great sensitivity) its disconserting to see them all at 1 time.
If you believe the signal you are seeing might be a data transmission try "Artemis Radio signal detection" program you can run from your PC. Download at: Click to download a copy of "US Navy Noise Handbook" 1) You see spikes appear and dont move as you scroll frequencies. This could be a software issue in PowerSDR, or your PC or Firewire
connection slowing down causing DSP conversion issues. Check PC services running in the background. Reset the software or your entire computer. Or this could be a birdie cause by the DSP hardware/software 2) You see signals across the Panadapter, but upon inspection determine that they are real signals but repeating at intervals across the
spectrum. This is frontend overload. You may need to add a Broadcast band filter to RX1 This can also be Switchmode or IF hash coming from sources all over your house (see below) 3) You see the waterfall noise level changes or jumps. This could be when you switch between bands, and because your antenna is designed for certain bands, its
efficiency on any band will change. When you leave a Ham band for a General Shortwave band, you dont have the same hardware filtering. or the PowerSDR or PC has issues and you may need to reset. Run remote desktop on your Laptop (running on battery) and go around your house and garage. Unplug everything and check the Panadapter. The
worst offender for noise/Birdie issues is the "Switchmode" power supply. Some can be so bad, they can be in your neighbors house. 1) Your Desktop PC switchmode will generate noise: Be carefull when putting the Computer to SLEEP, this can create noise throught the HF band, more than simply turning the PC off or leaving it ON. I think its becuase
the PC goes into LOW POWER mode and the switchmode is designed for larger loads. 2) Your Desktop PC CLOCK will generate noise: Check your bios settings for PC CLOCK "SPREAD SPECTRUM" try setting this both ways. 3) Your Laptop inline power supply can be a big noise generator. Sometimes its worse when its plugged in, but your laptop is
in lowpower mode. 4) Your Flat Screen TV: unplug it. 5) Light Dimmer 6) Garage Door Opener (the receiver circuit on the opener itself). 7) Your Cordless Drill battery Charger 8) Microwave oven (usually interferes with TV). 9) DSL or UVerse or Cable 10) BPL or HomePlug (Internet data over your home's AC wiring (Dish Network boxes have this
feature) Some of this may be removed by installing a CLAMP-ON Ferrite Bead designed to Choke HF
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